Task Architect

Task Analysis Software
*Taking the work out of task analysis*

User Guide

Task Architect Inc.

Version 3
# Table of Contents

## Chapter 1 – Welcome to Task Architect

- Welcome to TaskArchitect ................................................................. 1
- How do the Editions of TaskArchitect differ? .................................. 1
- About this manual ......................................................................... 2
- Purchase TaskArchitect ................................................................ 2
- Technical Support ......................................................................... 2
- Customer Service ......................................................................... 2

## Chapter 2 – Getting Started

- Introduction .................................................................................. 3
- Installing, Upgrading and Moving TaskArchitect .......................... 4
  - Requirements............................................................................... 4
  - Installing TaskArchitect ............................................................. 4
  - Upgrading from TaskArchitect 2 to TaskArchitect 3 ............... 5
  - File Compatibility ...................................................................... 5
  - Checking Your Version ............................................................. 5
  - Uninstalling TaskArchitect and/or Moving TaskArchitect to a different computer. ................................................................. 5

## Chapter 3 – Entering tasks

- Starting TaskArchitect and creating a new analysis file ............... 6
  - Create a New analysis using a template .................................... 7
  - Entering the name of the activity being analyzed .................. 8
  - Entering tasks as text in the Tabular View ............................ 8
  - Indenting tasks to form a hierarchy ....................................... 8
    - Collapsing and expanding the hierarchy .............................. 9
    - Navigating around the hierarchy and showing context tasks .. 9
  - Editing tasks and moving tasks within the hierarchy ............ 9
    - Moving Tasks ........................................................................ 10
    - Cut a single task ................................................................... 10
    - Cutting multiple tasks ......................................................... 11
    - Pasting tasks ......................................................................... 11
    - Drag and drop with sub-task selection ................................ 11
    - Moving tasks between TaskArchitect Files ....................... 11
    - Entering tasks graphically in the Overview and Left-Right View screens ................................................................. 12
    - Showing levels of the hierarchy ........................................... 12
  - Changing the task numbering and the way that text is displayed ................................................................................. 12
    - Task numbers ........................................................................ 12
    - Options for the display of information .................................. 13
Chapter 4 – Recording information about tasks: task properties

Using Task Properties in the analysis

Selection list (single selection or multiple selection)
Number
Text string
Picture
Task reference
Internet URL
Formula
Logical combination
Rating scale
Boolean property
Hyperlink
Duration
Map location
Cascading property values
Defining Properties
Importing property definitions from other files and from templates
Recording information about tasks – property values
Displaying and entering property values in the Tabular View
Recording task details in the Tabular View
General Description
Entering values in the Task Details Window
Entering values in the Form View
Using information recorded about tasks

Chapter 5 – Advanced analysis

Task Highlighting
Use formula and logical combinations to create new information about tasks
Perform calculations using all the tasks in the hierarchy – cascading values
Analysis Templates

Chapter 6 – Creating plans

Creating plans
Creating plans using the graphical editor
Task Ranges
Task Order
Creating Simple Plans
Creating Advanced plans
Chapter 7 – Displaying the results of the analysis

Chapter 8 – Using the results: Producing Reports and Exporting the analysis

Chapter 9 – Special reports: Link tables, Timeline and Location Map
### Collaboration Features
- Recording when tasks were last edited
- Marking when tasks are stopped and when they are completed
- Uniquely identifying each task
- Detaching and attaching tasks
- Re-attaching a task or file

### Saving and Exporting
- Moving tasks between TaskArchitect files
- Linking TaskArchitect files together

### Importing Files
- Importing non-TaskArchitect files
- Importing task names only
- Importing properties
- Importing from TaskArchitect files

### Other Features
- Copying Tasks from Excel and Pasting them into TaskArchitect
- Analysis Templates
- Check spelling
- Check the analysis
- AutoSave

---

Chapter 10 – Maintain the task analysis

- Collaboration Features
- Recording when tasks were last edited
- Marking when tasks are stopped and when they are completed
- Uniquely identifying each task
- Detaching and attaching tasks
- Re-attaching a task or file
- Moving tasks between TaskArchitect files
- Linking TaskArchitect files together
- Import
- Importing non-TaskArchitect files
- Importing task names only
- Importing properties
- Importing from TaskArchitect files
- Copying Tasks from Excel and Pasting them into TaskArchitect
- Analysis Templates
- Check spelling
- Check the analysis
- AutoSave
Chapter 1– Welcome to Task Architect

Welcome to TaskArchitect

Think of TaskArchitect as your drawing board for designing and analyzing tasks:

- It’s a dedicated tool for task analysis – no more compromises or messing about with programs that weren’t designed for the job,
- Built to support hierarchical task analysis – the nearest thing to a universal task analysis technique,
- Easy to configure to support many styles of analysis,
- Many customizable fields for you to record detailed information about tasks including multiple choice responses and pictures,
- Automatic re-numbering of tasks and plans; more time for you to focus on the analysis itself,
- Easy creation of plans – select tasks and logical arguments using point and click; both graphical and written representations of the plan as it is created,
- Many ways of displaying tasks - hierarchical diagrams, tabular analysis, timelines, link analysis, single tasks and their context; all automatically updated as the analysis is changed,
- Diagrams clearly laid out, print outs are carefully split across pages; customized reports on the whole analysis and detailed reports on single tasks available
- Easy integration – easy to import and export analyses (text files, spreadsheets, XML); import XML from MindManager™, export XML diagrams to Visio™
- Easy collaboration – changes can be tracked, tasks can be marked stopped or completed, parts of the analysis can be detached for other team members to develop then re-attached.

How do the Editions of TaskArchitect differ?

TaskArchitect Reader (our free trial) enables reviewers to open large files created using other Editions without needing to purchase TaskArchitect. TaskArchitect free trial in reviewer mode (ie a very large file has been opened) allows one property to be edited – this should normally be a text property to capture reviewer comments. This Edition is also designed to allow students to create small projects (up to 20 tasks, and 10 properties) in order to learn about task analysis. It also enables new users to try TaskArchitect before purchase. TaskArchitect Reader includes all of the features in TaskArchitect Pro except Attach/Detach tasks
TaskArchitect Standard supports standard sizes of analyses (up to 200 tasks and 20 properties). It includes the main features required to conduct standard analyses, but does not include Attach/Detach tasks.

TaskArchitect Pro supports the work required to carry out large, complex analyses (up to 4000 tasks and 100 properties) including complex analyses using features such as Location Map, Timeline and Link Analysis.

About this manual

TaskArchitect has been designed to be easy to use: it’s been designed for you to explore and quickly find your way around. Most of the product works just the way that other programs do. For that reason the manual doesn’t spend a lot of time explaining things that you already know. You’ll find that each topic is introduced by explaining the main ideas, followed by detailed instructions on how to use TaskArchitect.

An example file called ‘TaskArchitect example file’ is included in the TaskArchitect folder, with a shortcut from the Desktop, to illustrate many of the features of TaskArchitect.

If you are unfamiliar with task analysis you may want to read the accompanying document ‘An Introduction to Task Analysis using TaskArchitect’, and then return to the detailed guide.

For more information on how you can use task analysis in your business, see ‘Solutions’ on the web site www.TaskArchitect.com

Purchase TaskArchitect

The trial version of TaskArchitect allows you to try all of the features of the program. After the trial period has expired you may continue to use the program but you will not be able to save or print files.

Details of how to purchase TaskArchitect can be found at http://www.TaskArchitect.com/purchase.html

Technical Support


Contact Technical Support if you encounter problems while using TaskArchitect. Before contacting us, please prepare a clear description of the problem and know the version of your operating system, memory size and TaskArchitect version. To find the TaskArchitect version, start TaskArchitect and choose Help, About TaskArchitect from the main menu. Also have your TaskArchitect username and serial number available.

Support can also be obtained by emailing support@TaskArchitect.com

Customer Service

Contact Customer Service for non-technical questions such as registering your software, ordering new copies or upgrades of TaskArchitect, volume discounts, referrals to dealers, and general product, billing, or payment information.

Contact sales@TaskArchitect.com
Chapter 2 – Getting Started

Introduction

This manual describes how to use TaskArchitect – step-by-step. In most cases you will find that TaskArchitect features work just the same as those of any other Windows program – print, save, copy, paste etc. Go ahead and use them as you normally would.

To simplify learning about the program, the manual has been structured according to the steps that are normally carried out in performing a task analysis:

<table>
<thead>
<tr>
<th>Task Analysis step</th>
<th>TaskArchitect activities</th>
</tr>
</thead>
<tbody>
<tr>
<td>Decide on what to analyze and how to</td>
<td>Creating a New Analysis</td>
</tr>
<tr>
<td>analyze it</td>
<td></td>
</tr>
<tr>
<td>Collect the task information</td>
<td>Entering tasks</td>
</tr>
<tr>
<td></td>
<td>Recording information about tasks – task properties</td>
</tr>
<tr>
<td>Apply the task analysis notation</td>
<td>Creating plans</td>
</tr>
<tr>
<td>Display the results of the analysis</td>
<td>Using different task views</td>
</tr>
<tr>
<td>Verify the information collected</td>
<td></td>
</tr>
<tr>
<td>Use the results of the analysis</td>
<td>Producing reports and exporting the analysis</td>
</tr>
<tr>
<td>Maintain the task analysis</td>
<td>Collaboration features – stopped and completed tasks, tracking changes, detaching and attaching tasks Import Export Templates Auto-restore</td>
</tr>
</tbody>
</table>

TaskArchitect does not impose this order on you – you can carry out the analysis in any way that suits you and the problem that you are solving. For your first use of TaskArchitect it may be easiest to follow along with this order as you learn how to make the most of the program. If you are unfamiliar with task
analysis you may want to read the accompanying document ‘An Introduction to Task Analysis using TaskArchitect’, and then return to this detailed guide. For more information on how you can use task analysis in your business, see ‘Solutions’ on the web site www.TaskArchitect.com/Solutions.html

This part of the manual covers how to install and start TaskArchitect.

**Installing, Upgrading and Moving TaskArchitect**

When TaskArchitect is installed it also installs the required software (.net and HASP drivers) to run TaskArchitect if they are not already present but required for your installation, then installs the TaskArchitect application. TaskArchitect then needs to be activated before use.

To upgrade TaskArchitect from the Standard Edition to the Pro Edition you must first contact TaskArchitect with your order and serial number to purchase the upgrade, deactivate your current version (see below) then activate the new one.

To move your copy to TaskArchitect to another computer deactivate it before uninstalling. Keep a record of your serial number somewhere safe.

Please read the requirements section below before you proceed with the installation.

**Requirements**

**Software Requirements:**

This version of TaskArchitect requires at a minimum Windows XP and will run on any more recent version of Windows. It will also run on an Apple computer running a PC emulation program.

TaskArchitect is built using the .NET Framework. This is Microsoft’s software programming architecture designed to create the latest computer applications. In order for you to run next generation applications like TaskArchitect that utilize this new technology, you require the Microsoft .NET Framework Version 3.5 or later. This will be installed as part of the TaskArchitect installation process if your computer does not already have it. Similarly the HASP security drivers will also be installed if required for your version.

**Hardware Requirements:**

- A minimum of a 333MHz Pentium 4 is required.
- A hard drive with at least 50 MB of free space.
- A minimum of 1G of available memory (RAM).

**Installing TaskArchitect**

Follow these instructions to install the TaskArchitect program. If you are upgrading from an earlier TaskArchitect version, first see “Upgrading from an Earlier TaskArchitect Version” below.

To install TaskArchitect:

Find the **TaskArchitect Setup file**, which you downloaded after registering for the TaskArchitect free trial.
Double-click the TaskArchitect Setup icon to unzip the software.
Copy the contents of the folder to your desktop.
Double click on the file TaskArchitect_3.XX_setup.exe to start the installation process.
You will be guided through the process of installing the software which will include installing .net 3.5 and installing the HASP security drivers if required.

When the program has finished installing you will be asked to ‘Click Finish to exit the wizard’.
Go to the **Start** menu of Windows, select **All Programs**, then select **TaskArchitect**
TaskArchitect will then start and you will be asked for your name and serial number. Your serial number was sent to you by email when you purchased TaskArchitect. Enter your serial number and click on ‘OK’. The program will activate then start.

For further information about product activation see www.TaskArchitect.com/support.html

**Upgrading from TaskArchitect 2 to TaskArchitect 3**
Before upgrading from an earlier version of TaskArchitect you will need to contact TaskArchitect sales with your current serial number and order number in order to obtain a new serial number for TaskArchitect 3. The serial number can be found in the ‘About TaskArchitect box which is accessed via the Help menu. Upgrading will not affect your TaskArchitect files. Simply follow the instructions above for installing TaskArchitect.

**File Compatibility**
TaskArchitect is fully compatible with all files from earlier versions of TaskArchitect.

**Checking Your Version**
To check the version number of TaskArchitect, go to the Help menu and choose About TaskArchitect.

**Uninstalling TaskArchitect and/or Moving TaskArchitect to a different computer.**
When you installed and activated TaskArchitect on your computer the process of activation locked your serial number to your computer’s hardware. In order to use the serial number to activate TaskArchitect on a different computer you must first de-activate and uninstall TaskArchitect on your current computer. To de-activate your serial number:

- Make a note of your TaskArchitect serial number. This can be found in the ‘About TaskArchitect box which is accessed via the Help menu.
- You must be connected to the internet in order to deactivate the serial number.
- In TaskArchitect pen the Tools menu
- Select the item Deactivate TaskArchitect.
- Wait ten minutes before installing and activating TaskArchitect on a different computer in order to allow time for the de-activation information to be sent to all of our servers.
Chapter 3 – Entering tasks

This section describes the following actions:

- Entering the name of the activity being analyzed
- Entering tasks as text in the Tabular View
- Indenting tasks to form a hierarchy
- Navigating around the hierarchy and showing context tasks
- Editing tasks and moving tasks within the hierarchy
- Entering and editing tasks graphically in the Left-Right View and Overview
- Changing the task numbering and the way that text is displayed
- Changing the amount of the hierarchy that is displayed
- Marking tasks as stopped or completed

The Tabular View is one of the views that TaskArchitect provides of your analysis. For more on the views available see ‘Chapter 6: Displaying the results of the analysis - using different task views’.

In the Tabular View you will see the tasks, and their associated plans and properties displayed in the form of an indented list. The indented list and the task numbering show the hierarchical relationship between the tasks.

The Tabular View is commonly used for quickly entering tasks and arranging them to represent how the user accomplishes the main goal. Tasks can also be entered graphically using the Left-Right view.

For information on how to import tasks from other applications please see ‘Chapter 8: Maintain the task analysis.’

Starting TaskArchitect and creating a new analysis file

To start TaskArchitect from Windows and creating a new file:
Open the Windows Start menu,
Click on Program Files,
Click on the TaskArchitect folder
Select TaskArchitect
TaskArchitect will open showing the new file dialogue which provides you with options about how to create a new file or open a file.

Three of these options - Create a New Analysis, Open a Recently-used File and Open another File – are all standard ways of creating or opening files. In addition, TaskArchitect provides an option to create a new file using an analysis template that is a short-cut to setting many of the options in TaskArchitect.

**Create a New analysis using a template**

TaskArchitect contains a number of pre-defined templates to help you to carry out different types of analyses. The standard version of TaskArchitect comes with the following templates:

- Basic Task Analysis,
- Competency-Based Training
- Human Error Assessment
- Timeline analysis
- Cognitive Work Analysis,
- and Risk analysis.

These templates define the information you can record about tasks in addition to the names of the tasks and the plans linking them together. For instance you may want to record the time to complete a task or the role of the person who carries out the task or the tool used to perform the task. For further information about this topic see ‘Using task properties in the analysis’

For information on how to define your own templates see ‘Maintaining the analysis – templates’, or Contact Customer Support ([support@TaskArchitect.com](mailto:support@TaskArchitect.com)) in order to request customized templates to suit your style of analysis.
Using the Basic Task Analysis template will provide you with an understanding of how all of Task Architect’s templates work.

Select the Basic Task Analysis template and click on OK.

Now you’re ready to start entering tasks.

**Entering the name of the activity being analyzed**

When TaskArchitect first starts it opens in the Tabular View mode. This shows tasks as an indented list.

At the top of the Tabular View is a space for you to enter the name of the task that you are analysing, for instance ‘operate power plant’ or ‘set timer’. The rest of the tasks that you enter in the analysis will be sub-tasks of this one.

This is the only task that is not numbered. You may change name of this task at any time by selecting the task and re-typing the text.

**Entering tasks as text in the Tabular View**

- To enter tasks simply type the name of the task and press Enter. The cursor will move to the next line, ready to accept the next task.
- To add a new task that is at the same level as the current task, press the green “plus” symbol on the Toolbar or simply press Enter after finishing typing the current task that you are working on. You can do the same thing by using the Tasks menu and selecting Add Task.
- To add a task at a higher level than the current one from the Tasks menu and select Add Higher-Level Task. NOTE — you cannot add tasks above the highest level task.
- To add a task at a level lower than the current task (a sub-task) from the Tasks menu and select Add sub-task.

**Indenting tasks to form a hierarchy**

The arrangement of tasks into a hierarchy shows how a task is accomplished by performing a number of its sub-tasks.
Tasks may be promoted no more than one level below the immediate higher-level task, i.e. a sub-task can be promoted from 1.1 to 1.11, but not immediately to 1.1.1.1

There are a number of ways that you can indent the tasks (promote or demote) to show their hierarchical relationship.

The quickest way to promote or demote the task is: Press Tab (demote) or Shift and Tab (promote).

You may also:
Use the blue arrows in the tool bar, or
Use the Task menu and select Promote or Demote

When you demote or promote a task, all of its sub-tasks are moved the same way in the hierarchy.

**Collapsing and expanding the hierarchy**

Notice that as you demote a task to be a sub-task, the higher-level task acquires a “-” sign to its left, indicating that it has sub-tasks. To collapse or expand the hierarchy to control whether sub-tasks are shown or not, click on the “-” or “+” sign next to the task.

**Navigating around the hierarchy and showing context tasks**

When you are in the Tabular View you can use the arrow keys or the vertical scroll bars to navigate up and down the list.

Notice that as you scroll up and down a long task list TaskArchitect will always show the parents of the top child in the list, highlighted in blue. These are called context task. They enable you to always see the context of the top task in the list, even though you may have scrolled quite a long way down the task list. To turn off the display of context tasks in the Tabular View, from the View menu select ‘Context Tasks’.

**Editing tasks and moving tasks within the hierarchy**

The list of tasks is made up of the task number and the name of the task. When you click on the number of the task you select the task itself. When you click on the text for the name you are only selecting the text. This separation allows you to do things like select and move the task or just select and edit the name of the task.
When you select a task name by clicking on the text, only the text becomes highlighted.

<table>
<thead>
<tr>
<th>3.1.1.1.1 Find code with errors</th>
</tr>
</thead>
<tbody>
<tr>
<td>3.1.1.2 Fix the errors</td>
</tr>
<tr>
<td>3.1.2 Test Locally</td>
</tr>
<tr>
<td>3.1.2.1 Run project</td>
</tr>
<tr>
<td>3.1.2.2 Log in locally</td>
</tr>
</tbody>
</table>

When you select an entire task, by clicking on the task number, the whole task is highlighted in yellow:

<table>
<thead>
<tr>
<th>3.1.1.2 Fix the errors</th>
</tr>
</thead>
<tbody>
<tr>
<td>3.1.2 Test Locally</td>
</tr>
<tr>
<td>3.1.2.1 Run project</td>
</tr>
<tr>
<td>3.1.2.2 Log in locally</td>
</tr>
</tbody>
</table>

When you select several tasks, by clicking on the number of the higher-level task in the group, the group of tasks gain a yellow boundary:

<table>
<thead>
<tr>
<th>3.1.1 Open Development Project in Visual Basic</th>
</tr>
</thead>
<tbody>
<tr>
<td>3.1.1.1 Fix bug</td>
</tr>
<tr>
<td>3.1.1.1.1 Find code with errors</td>
</tr>
<tr>
<td>3.1.1.1.2 Fix the errors</td>
</tr>
<tr>
<td>3.1.2 Test Locally</td>
</tr>
</tbody>
</table>

When you select a higher level task, you also select all of its sub-tasks at the same time. This makes it easier for you to move sections of the task analysis around.

**Moving Tasks**
You can move one task or several contiguous tasks. When you move a task, all of its sub-tasks are also moved.

You can move tasks by cutting and pasting, or by dragging and dropping, or quickly within a particular level using Move up or Move down in the Edit menu (ALT ↑ or ALT ↓). To move tasks between TaskArchitect files see ‘Chapter 8 – Maintain the task analysis.’

For cut and paste the first step is to cut the tasks that you wish to move:

**Cut a single task**
You can cut, copy and paste a single task and its sub-tasks, into the same file by following the steps below.

Select a single task by clicking on the task number, and
From the main menu choose **Edit** and select **Cut** or **Copy**.

Or
Right-click on the task number and
Select **Cut** or **Copy**
Once you have made your selection you are ready to paste the task anywhere in the file.

**Cutting multiple tasks**
You can cut and paste multiple sections, as long as they are a contiguous set of tasks (all on the same level of the hierarchy). Their sub-tasks will be included in the cut and paste.

Select a single task by clicking on the task number, and
While holding the shift key down, click on the last sub-task that you want to select
From the main menu choose **Edit** and select **Cut** or **Copy**

**Pasting tasks**
The after cutting or copying, the second step is to paste the tasks back into the hierarchy:

Either use the menu commands or right-mouse commands:

Menu commands:
Indicate the location you want to paste your tasks by clicking on the task number immediately preceding where you would like to insert the tasks.
From the main menu choose **Edit** and select **Paste**.

Right Mouse commands
Right click on the task number immediately preceding where you would like to insert the tasks.
Select **Paste** from the list of right-mouse commands.

**Drag and drop with sub-task selection**
You can drag and drop tasks and sub-tasks anywhere in the Tabular view, just like you would drag and drop text in a word processor.

Select the task or group of tasks using the mouse to point at the task number and the shift key to highlight a block of tasks.

Insert the tasks by left clicking on any of the task numbers selected and dragging them to the point in the list where you would like to insert them.

**Moving tasks between TaskArchitect Files**
There are three methods of moving tasks between TaskArchitect Files. The easiest is to open both files using TaskArchitect then cut or copy and paste them between files. You can also use the Import feature and select the type of file to be ‘TaskArchitect’. Additionally, you can export the files as data then import them into the other TaskArchitect file. See ‘**Chapter 8 – Maintain the task analysis**.’ for more information on all of these features.

Open the file you wish to paste tasks to/from using ‘Open’ in the file menu.
In order to be able to see more than one open TaskArchitect window at once ‘Restore’ the size of the current window by clicking on the restore button at the top right of the window:
Select the task(s) that you want to move by clicking on the task number of the highest task to be moved.
Cut or copy the tasks by either using CTRL X/CTRL C or Copy/Paste from the Edit/Right mouse click menu.
Select where to paste the tasks by, in the file you are moving the task(s) to, clicking on the task number of the task above where you want the tasks to be pasted.
Either use CTRL V or Paste from the Edit/Right mouse click menu to paste the tasks.

**Entering tasks graphically in the Overview and Left-Right View screens**
The Overview and Left-Right View screens are different ways of viewing the analysis. Detailed information about these and other views of the analysis can be found in "Chapter 6 – Displaying the results of the analysis".

To open the Left-Right view click on the Tabular-View icon in the tool bar.
To open the Overview screen click on the Tabular-View icon in the tool bar.

Just as in Tabular view, task names can be entered, and tasks can be indented, moved, and edited. The same principles apply here:
- Add a task by pressing return or clicking on the + button or using Add Task in the right mouse click or Task menus.
- Edit the task name by clicking on the task name then typing.
- Indent a task using the tab key, the indent button or the Edit menu.
- Expand or collapse a group of tasks by clicking on the + or – adjacent to the task number of the highest task in the group.
- Select a task by clicking on the task number.
- Move tasks by either dragging them or using copy/cut then paste to move them. When dragging a task the location where the task will be dragged to is indicated by a thick black line. Places where a task cannot be dropped are marked with a no entry sign.

**Showing levels of the hierarchy**
As you decompose the main goal into sub-tasks the task list will get longer and the number of sub-tasks will increase. Sometimes it is useful to only show the top levels of the hierarchy and hide some of the details so that you can get a higher perspective of the analysis, hiding some of the details.

TaskArchitect enables you to specify to what depth the hierarchy should be displayed. This is accomplished by clicking on the appropriate number in the levels section of the toolbar.

This part of the toolbar includes numbered squares (from 1 to 8) as well as a greater-than sign (>). Each number represents the depth of the hierarchy currently displayed. You can also select the greater than sign > to show all levels.

**Changing the task numbering and the way that text is displayed**

**Task numbers**
The task number of a task is automatically allocated and adjusted as you create and move tasks. This means that you never have to adjust the task number, however you alter the analysis. Task numbers can be either shown in abbreviated form (only their immediate position in the hierarchy is indicated e.g. ‘1’) or in full (E.g. ‘1.1.3.1’).
You can change the format of the numbering according to your particular style of analysis, at any time during the analysis:

From the Main menu select Tasks then select Format Numbering …

![Numbering Options](image)

You can specify the particular style that you want to use for the first three levels, then the style to use for any subsequent levels.

You can start the task numbering from any number. In the Numbering Options dialogue enter the first number in the “Level 1” box. You can even start each task ‘number’ with text for instance if you use the text ‘Goal’ as the “Level 1” label then the first sub task will be “Goal. 1”. To re-set the numbering so that the highest level task is not numbered and the first sub task is 1, delete any information in the “Level 1” box of the ‘Numbering Options’ dialogue.

To show a short form of the task numbering (just the last relevant digit), from the Task menu select ‘Show complete numbers in all diagrams’ so that the check mark next to it is removed. To switch between short form numbering and complete numbering in plans, from the View menu select ‘Show complete numbers in plans’.

**Options for the display of information**

The details of how each view is displayed on the screen are configurable using the Options dialogue – select the Edit Menu, then select Options.

Take care in choosing colors in this dialog, especially text colors. Choosing a dark background with light text will only work on the screen - printouts always use a white background, so light text will not show up correctly. The “boxes in charts” option changes the width of boxes in the overview, page view, L-R view and timeline report. The height of boxes is automatically set to fit the text.
Marking tasks as stopped and completed

At some point in your analysis you will find that you have described the sub-tasks in sufficient detail for the type of analysis that you are carrying out. For instance, you may have reached a level of detail where the next level of analysis is not required because the steps are self-evident, or maybe not needed for the analysis you are conducting. The rule that describes when you have reached sufficient detail is called the ‘stopping rule’ for the analysis. For further information on stopping rules see the document ‘Introduction to task analysis using Task Architect.’

In order to keep track of which tasks do not need further analysis you can mark a task as ‘stopped’. Stopped tasks can be edited, but sub-tasks cannot be added to them.

Either

- Right click on a task name and select stopped’
- or
- From the Main menu select Tasks then select stopped.

Tasks that have been marked stopped are shown with a lock symbol next to them:

3.1.2 Find bucket

When you have decided that the analysis is correct and does not require any further review or changes tasks can be marked as completed. Note the difference between ‘stopped’ and ‘completed’ – stopped means no more detail is required, ‘completed’ means that the analysis has been checked and no more changes need to be made. Completed tasks cannot be edited nor have sub-tasks added.

Tasks that have been marked completed are shown with a check mark next to them:
Either:

Right click anywhere on a task and select `completed` or

From the Main menu select `Tasks` then select `stopped`.

If a parent task is marked as completed, the system will ask if all of the tasks should be marked as completed.

Now that you have created a task decomposed into a hierarchy of sub-tasks, the next step is to specify plans that describe when the sub-tasks are carried out.
Chapter 4 – Recording information about tasks: task properties

This section describes the following actions:

- Using Task Properties in the analysis
- Defining Task Properties
- Importing task properties from other files and templates
- Recording and displaying information about tasks – property values

**Using Task Properties in the analysis**

Properties allow you to record extra information about each task in addition to the task name, the sub-tasks and the task plans. This can be used to turn your task analysis into a requirements capture tool. For instance, you may want to record who carries out the task, what tools they use and the types of error that they might make and the consequences of error. Properties can also be used to create database references. For instance, you may want to link a task to a particular item in a database by recording as a task property the key (e.g., a unique number) for that database record. Up to 40 different properties can be defined for each analysis. As you learn how to carry out further analysis using the task properties (see ‘Chapter 6 – Advanced analysis’) you will see new ways of using TaskArchitect to make decisions about how to improve human performance.

Property values can be displayed in the Tabular View, in the Form View and in the Task Details Window at the right of the main view window. Several columns of properties can be displayed in the Tabular view right next to the task hierarchy and can be edited directly in the columns – just like a spreadsheet. As the analyst selects different tasks in any view, the different task details including the property values, can be displayed in the Task Details Window. The Form View can also be used to review all of the task details at once. One of the most powerful ways of displaying property values is using the Task Highlighting feature to change the way that task names are displayed in each of the views – the task box shape, the background to the task name, the font type, the font colour and the outline of the text box can all be changed. For more information on Task Highlighting see ‘Chapter 6 – Advanced analysis’. This is just one example of how you can leverage the information you’ve collected to analyse the human performance issues.
There are 13 types of property:

**Selection list (single selection or multiple selection)**
The analyst is able to select one or more pre-defined values for this type of property. For instance, for a property called ‘operator’ the values ‘technician’, ‘assistant’ and ‘supervisor’ may be pre-defined. Depending on the type of property selected (single value or multiple value) the analyst can select one or more values from the list. Items in a selection list can also be assigned flags (graphical symbols) that can be displayed in the Tabular View. Values for selection properties can be loaded from a flat file using the ‘Import Values’ button in the properties definition window. Large numbers of property values can be defined for each property.

**Number**
The analyst may enter any number as a value for this type of property. For instance, for a property called ‘duration (minutes)’ the analyst may enter any number to indicate the time it takes to complete a task (in minutes). Number properties can be defined as either integers or real numbers. If it is defined as an integer, and the range of values is constrained to be 30 or less, the user will be provided with a drop-down selection for entering the value. This is a convenient way of entering scales.

**Text string**
Up to 32 kb of text may be entered for this type of property. For instance, a property called ‘description’ might be defined in order to allow the analyst to provide a more detailed description of the task.

**Picture**
The type of property allows the analyst to link to a file containing a picture relevant to the task. All pictures must be stored in the same directory as the analysis file. The picture may be displayed in the Task Details window or Form view (see below).

**Task reference**
This is used to make a reference to another task and essentially acts as a pointer to a different part of the hierarchy. It may be used to indicate that a given task would be broken down in the same way as the reference task. This enables the analyst to put pointers between identical tasks rather than repeat them in every place that they occur. A reference property may also be used to indicate a dependency, where the reference task must be completed before the given task begins. This allows the analyst to record dependencies which cut across the hierarchical structure of the analysis.

**Internet URL**
This property enables a pointer to be made to an external URL – such as a document, a graphics file or video. It can be used to indicate documents relevant to the property, for instance sources of technical information or relevant standards.

**Formula**
The type of property supports the numeric calculation of a result based on the values of other properties. Both rating scale properties and numeric properties can be used in the calculations. It can be used to carry out analysis to emphasize the characteristics of tasks. For instance, duration and cost can be combined to highlight the most expensive operations. Each property can be weighted in the calculation. The following calculations can be performed – weighted sum, weighted average, product, minimum and maximum. To subtract a value, provide a negative weight to the value to be subtracted.

**Logical combination**
The property is used to create a result based on the particular combination of values entered into other properties. This is sometimes referred to as a look-up table. Both rating scale properties and selection properties can be used in the calculations. An example of this type of calculation is if you
want to work out whether training should be provided for a particular task the frequency, difficulty and importance of a task needs to be considered - a DIF analysis. For instance, if the frequency of the task is high, the difficulty is low and the training is low then no training is required, but if the difficulty was high then training is required. This is a simple way of reproducing the effect of programming very complicated calculations.

To define the values used in the algorithm select up to three properties that contain the values that will be compared. A table will be generated for the combination of all of the possible values. Click to the right of the line of combinations in order to enter the resulting value of those combinations.

<table>
<thead>
<tr>
<th>Properties to combine:</th>
<th>Result:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Difficult</td>
<td>Important</td>
</tr>
<tr>
<td>yes</td>
<td>Very</td>
</tr>
<tr>
<td>yes</td>
<td>Very</td>
</tr>
<tr>
<td>yes</td>
<td>Very</td>
</tr>
<tr>
<td>yes</td>
<td>Moderate</td>
</tr>
<tr>
<td>yes</td>
<td>Moderate</td>
</tr>
<tr>
<td>yes</td>
<td>Moderate</td>
</tr>
</tbody>
</table>

**Rating scale**
The property is used to capture the results of ratings, for instance about task difficulty or likelihood of errors. The number indicates the magnitude of the rating and can be used in property calculations; the accompanying text describes the magnitude of the rating.

**Boolean property**
This property is useful for capturing yes/no answers to questions. It has three selections – yes (check mark), no (cross) and no value (null). The states can be switched between by pressing the space bar. It acts in the same way as a single selection property except the use of the space bar to select values makes it faster to answer yes/no questions and the check and cross onscreen make the answers more obvious.

**Hyperlink**
This property is used to make links between different TaskArchitect files. It is similar to the Task Reference property in that its values are pointers to other tasks, but a hyperlink is also a pointer to a task in a different file.

**Duration**
This property is used to record information about the how long a task takes. As well as being a simple record of task time it can also be used in timelines to draw boxes to represent how long a task takes. Durations can be used in calculations. Duration can be displayed in several formats:

<table>
<thead>
<tr>
<th>Format:</th>
</tr>
</thead>
<tbody>
<tr>
<td>1h:02m:03s</td>
</tr>
<tr>
<td>1:02:03:0</td>
</tr>
<tr>
<td>1.02:34 hr</td>
</tr>
<tr>
<td>1:34:02 min</td>
</tr>
<tr>
<td>1.34:02 sec</td>
</tr>
</tbody>
</table>

**Map location**
This property is used in conjunction with the Location Map report to identify on a map (a picture of the workplace) where a task is carried out. The Location Map report can show how different operators
move between map locations in order to carry out their work. For more information on Location Map see Chapter 7 - Displaying the results of your analysis.

**Cascading property values**

As part of the definition of the task property, you can specify whether the values entered are used in calculations across the task hierarchy. For instance, the values can be cascaded down from the top task to the bottom task, or added up from the bottom task to the top task. In the property definition dialogue this is called the ‘property value cascade’ and is set using the drop down to the right of the property type. Different types of properties have different types of property value cascade. For more information on property value cascades and how to use them see Chapter 5 – Advanced analysis

You may change the definition of a property at any time until you enter data for that property. However, once data has been entered for a property – for instance you have started filling in numeric values for the property ‘time’ – the type of property can only be changed to be a text property.

**Defining Properties**

Properties can be selected and defined using the Analysis Set-up Wizard when the analysis file is first opened. In addition properties can be quickly added to the analysis in the following manner:

From the Properties menu click on Define Properties

A dialogue will be displayed where you can define the type of property using the drop down menu on the right of the dialogue. If it is a selection type property you can also define the values that the analyst can select. Values for multiple select properties can also be imported from lists in text files. You may also select flags that will be displayed whenever a particular value is selected for a task:
Flags can be added to any selection list type property. They are selected simply by clicking on the one that you want to use. These will be displayed in on screen and in print outs next to the associated property values.

Custom flags can be obtained by contacting support@TaskArchitect.com.

The position of the property in the list can be changed by using the up and down arrows in the dialogue. The position of the property affects where it appears in the list of properties but does not affect where it appears in the Tabular View. The location of the property in the Tabular View is changed by selecting from the View menu ‘Show tabular view property chooser …’

A description of the property can be recorded in the box ‘Description’. This is a useful way to communicate the definition of the property to other users.

**Note:** You may change the definition of a property at any time. However, once data has been entered for a property – for instance you have started filling in numeric values for the property ‘time’ – the type of property can only be changed to be a text property type.

**Importing property definitions from other files and from templates**

Property definitions can be imported at any time into a TaskArchitect file from another TaskArchitect file or template. This allows you to keep pre-defined libraries or collections of property definitions that you have found useful in other analyses and apply them at any time in your current analysis project.

From the Property menu select ‘Import property definitions …’ and in the following dialogue select the file that you want to import the property definitions from. In the next dialogue box select the property definitions that you want to import.

**Recording information about tasks – property values**

Information about tasks – the property values - can be entered directly into the task property columns of the Tabular view (just like in a spread sheet), into the Task Details window and in the Form View.

The task property columns can be used to show next to the list of tasks all of the property values that have been entered for tasks and to enter the task values. The task property columns are normally located on the right hand side of the Tabular View window. The Task Details Window contains a compressed view of all of the information recorded about a the particular task you have clicked on and is always accessible at the right hand edge of the main window along side whatever window you have open. The Form View window is a dedicated view of all of the information about the particular task you have clicked on with ample space for displaying every piece of information.
<table>
<thead>
<tr>
<th></th>
<th>Have Adventure</th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>1 Get up</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>2 Feed the chickens</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>2.1 Go to yard</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>2.2 Get feed</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>2.2.1 Spread on ground</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>3.3 Milk the cow</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>3.3.1 Prepare to milk</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>3.3.1.1 Find cow again</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>3.3.1.2 Sit down</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>3.3.3 Find udders</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Difficult** | **Important** | **Frequency** | **Training need** | **expensive?**
---|---|---|---|---
| yes | Very | Moderate | Frequent | 1 | ✔
| yes | Not | Moderate | Frequent | 3 | ✗
| | | | | |
| | | | | |
| | | | | |

**Task: 1**

**Monitor surveillance information**

- **Boxed:** No
- **Completed:** No
- **Plan:**

**Task Description:**

- **Equipment used:**
- **Task Allocation (U/L):** Both (ATCO and assistant)
- **Task Allocation (U/L):** Both (TMU and CMO)
- **Delay possible:**

**Last changed on Mar 22, 2009 by melaniwalls**

**Version:** 21/41/2011
Displaying and entering property values in the Tabular View

Columns of task properties can be shown and edited in the right hand side of the Tabular view – in the task property column area.

The task property area can be scrolled horizontally independently of the task names, so you can display multiple columns of properties, as required for the analysis. The total number of properties that can be displayed in the Tabular view at one time depends on the width of the columns for each property. To select which properties should be shown and the order in which they should appear...
either double click on the blue border at the top of the property column area or from the View menu select 'Data columns in list …'

The amount of space available for property columns can be adjusted by either changing the size of the main TaskArchitect window or by dragging the left hand border of the property columns window. If the Task Details window is open more space can be allocated to the property columns area by closing the Task Details Window. The width of individual columns can be added by clicking on the border between the columns then dragging it to the left or the right.

When the Tabular View is printed normally half of the page shows the task names and half shows the property columns, however the amount of space allocated to the task names can be adjusted in the Print Preview function - see Chapter 8 – Using the results: Producing Reports and Exporting the analysis. To have more flexibility in showing the values of properties in print outs, see the section below on Reports and the section on exporting data.

Recording task details in the Tabular View

Property values can be entered directly into the columns by clicking on the value or the space where the value should go. Once you have entered information in the property columns you can navigate around the columns using the arrow keys.

To enter the value for a single selection type property or a rating scale, use the drop down menu to the right of the property to pick a value (as shown below) or type the first letter of the property value
To enter a value for a multiple selection type property click on the space where the value will go then check off the property values in the list that is displayed. To close the list either press Enter (which will then open the selection list for the values to be entered for the next task), or click on the space immediately to the left of the list or click on another property value or task.

For number properties the value can be typed directly into the box to the right of the property name:

For text properties the text can be entered directly into the box or the entire text can be displayed and edited by clicking on the ellipsis to the right of the value box.

Pictures, task references, URLs and hyperlinks are entered by clicking on the ellipsis to the right of their value box then following the instructions in the dialogue that is displayed.

When selecting task reference and hyperlink you will be provided with a list of tasks in the current file for you to select from. When selecting a hyperlink you will first be asked for the name of the file where the tasks are contained.
Pictures must be stored in the same directory as the analysis file. They can only be entered into the analysis after the file has been saved for the first time.

To link a picture to a task, type the file name or browse the file directory and select the name of the picture you want to link.

Boolean properties (selection lists with two fixed values) are entered by clicking on the property value to change it until it represents the value that you want or pressing the space bar to change the state to the one required.

**General Description**
The General Description is a special type of property that is a place to record notes about the analysis – for instance aims, state of the analysis, techniques and assumptions, sources and reviewers. The property is associated with the file as a whole, not a particular task. To fill in details of the general description, from the Properties menu select ‘General Description’.

**Entering values in the Task Details Window**
Properties for any task can be viewed and entered using the ‘Task Details’ window.
To view the Task Details window either:
Press F6 (Function key 6), or
From the View Menu select ‘Task Details’

To hide the Task Details window either:
Press F6 (Function key 6), or
From the View Menu select ‘Task Details’

Note – the Task Details window cannot be opened while the Form View is open.

The values for the properties can be entered in this window or in the Form view Window in the same way that they are in the task property area. In addition the amount of space allocated to each of the property values can be adjusted by dragging the lines dividing up these windows to the left/right and up/down.
To open the Form View window either:

From the View menu select Form View from
or
Click on the Form View icon on the toolbar

**Entering values in the Form View**

Form view provides you with the largest amount of space for viewing and entering properties for a single task at a time. Use the Form View when the structure of the analysis is well defined (you don’t intend to move the tasks around the hierarchy very much) and a large number of properties need to be entered (one task at a time), or when dealing with several text properties which contain large amounts of text.
Using information recorded about tasks

The information that is recorded about the tasks is not only a capture of requirements; it's the basis for many design decisions. Task highlighting, cascading property values, pre-defined analysis templates, property value formulas and property value combinations provide powerful ways of exploiting the information that you have captured. For information on how to use properties for further analysis of tasks see the next chapter ‘Chapter 6 – Advanced analysis’. For information on how to include properties in reports and exporting the value of properties, see ‘Chapter 7: Using the results - Producing Reports and Exporting the analysis’.
Chapter 5 – Advanced analysis

This section describes how to use some of the advanced features of task properties to extend your task analysis. While the process of documenting tasks and organising them into a task hierarchy has been the central part of a task analysis project, TaskArchitect now enables further analysis to be undertaken through the use of task properties. Many of the functions that could only be carried out using a spreadsheet can now be performed within TaskArchitect:

- Automatically highlight tasks according to information recorded about them
- Use formula and logical combinations to create new information about tasks
- Perform calculations across all of the tasks in the hierarchy – cascading values
- Load and create analysis templates

**Task Highlighting**

Task Highlighting brings the task diagrams to life by highlighting all of the tasks that have particular property values. This enables you to automatically link the way that tasks are displayed in the graphical views to the values of properties. For instance, if a multiple selection type property is defined called ‘Operator Type’, all of the tasks conducted by the value ‘Technician 2’ could be highlighted. The task box shape, the text colour and type of text for the task name can be altered, as can the background shading for the task box and the colour of the border of the task box. Each level in the hierarchy of tasks can also be given a particular highlight.

Task highlighting can be turned on and off for the whole analysis, using “Task highlighting in all diagrams” in the View menu), or turned on or off in just the Tabular view (using ‘Task highlighting in Tabular view’ in the View menu).
If a selection property is selected for applying task highlighting, carefully consider how you will combine box colour, box edge, text type and text colour for highlighting. For multiple selection properties, if a background colour has been selected for two different choices, and both choices were entered by the user only the selection, the colour that appears nearer the top of the list of colours will be used.

If the selections for task highlighting result in more than one colour or font attribute applying to the same task, the property that appears nearer the top of the list of properties in the task highlighting dialogue will dominate.

Task highlights print in all views except tabular view, where only the box outline and text style highlights print (in order to facilitate lack and white printing).

To highlight all of the tasks that contain a given property value:
From the Tasks menu select 'Task Highlighting'.
Click on the tab for the attribute you want to highlight (Shading, text colours, borders, text style) Either select the property you want to define adjacent to the colour that you want to use, or select any of the colours then later re-define the colour to be used
Select the property value that you want to highlight, then select any argument (greater than, less than etc) as is appropriate for the property type:

<table>
<thead>
<tr>
<th>Property type</th>
<th>Logical arguments in task highlighting</th>
</tr>
</thead>
<tbody>
<tr>
<td>Single and multiple selection properties</td>
<td>=, blank, non-blank</td>
</tr>
<tr>
<td>Numeric properties</td>
<td>&lt;, =, &gt;, &lt;&gt;</td>
</tr>
<tr>
<td>Rating scale</td>
<td>&lt;, =, &gt;, &lt;&gt; (the rating value)</td>
</tr>
<tr>
<td>Logical combination</td>
<td>Blank, non blank</td>
</tr>
<tr>
<td>Formula</td>
<td>&lt;, =, &gt;, &lt;&gt;</td>
</tr>
<tr>
<td>Text</td>
<td>Blank, non blank</td>
</tr>
<tr>
<td>Task reference</td>
<td>Blank, non blank</td>
</tr>
<tr>
<td>Boolean</td>
<td>Blank, non blank</td>
</tr>
<tr>
<td>Picture</td>
<td>Blank, non blank</td>
</tr>
</tbody>
</table>
If you want to change the colour that will be used click on the colour then use the dialogue to define the colour you want to use.

<table>
<thead>
<tr>
<th>Hyperlink</th>
<th>Blank, non blank</th>
</tr>
</thead>
<tbody>
<tr>
<td>URL</td>
<td>Blank, non blank</td>
</tr>
</tbody>
</table>

Continue selecting properties you want to highlight until you have selected all that you want to see, and then click ‘OK’. The tasks with the value of properties that you selected will be highlighted in all views.

**Use formula and logical combinations to create new information about tasks**

The definition of the property types ‘formula’ and ‘logical combinations’ was described in 'Chapter 4 – Recording' information about tasks: task properties'.

**Perform calculations using all the tasks in the hierarchy – cascading values**

Need to know the total time taken for a task based on the time for each of its sub-tasks, or a list of all of the tools used in the sub tasks? The cascading features of the properties in your analysis enable you to perform these types of calculations. Formula properties and Logical Combination properties perform calculations within the information for a single task. In contrast, cascading aspect of properties enables calculations to be performed across some or all of the tasks in the hierarchy.

‘Cascading’ allows you to flow all the values for a property up the hierarchy. It can be a simple as making all subtasks the same value as the highest level task or more complex such as the addition of all of the values up the hierarchy so that the highest level task is the sum of all sub-tasks.

The cascading actions that you can define depend on the type of property that you are working with. In general, properties that contain numbers that you have entered (numbers, rating scales) can be used to perform calculations and can have their values flowed up or down the hierarchy while properties that are references to other things (URLs, hyperlinks, pictures) can have their values flowed up and down. There are also some special types of cascade such as Concatenation, Or, And, Maximum and Minimum. The types of cascade and the property types where they can be used are described in the table below.
<table>
<thead>
<tr>
<th>Cascade Type</th>
<th>Effect</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Downwards: value of parent task</td>
<td>All sub-tasks are given the value of the parent task</td>
<td>Set initial defaults for values, provide examples of what needs to be entered into the property, describe key issues that need to be examined in the analysis</td>
</tr>
<tr>
<td>Upwards: Sum of sub-task values</td>
<td>Each higher level task is given the total value of all of its sub-tasks. The highest level task is given the value of all of the subtasks.</td>
<td>Adding up time for all sub-tasks; adding up costs for all sub-tasks; sum of difficulty ratings</td>
</tr>
<tr>
<td>Upwards: Average of sub-task values</td>
<td></td>
<td>Average waiting time; average operator lift requirements; average of difficulty ratings</td>
</tr>
<tr>
<td>Upwards: Product of sub-task values</td>
<td></td>
<td>Number of repetitions.</td>
</tr>
<tr>
<td>Upwards: Maximum (highest sub-task value)</td>
<td></td>
<td>Maximum number of operators per sub-task; maximum number of key-strokes per sub-task; longest duration sub-task; longest waiting time; highest product satisfaction rating; highest difficulty rating</td>
</tr>
<tr>
<td>Upwards: Minimum (lowest sub-task value)</td>
<td></td>
<td>Lowest usability rating given;</td>
</tr>
<tr>
<td>Upwards: Concatenate sub-task values</td>
<td></td>
<td>List of all of the risks in the tasks, list of all the operator names; list of all the screen widgets</td>
</tr>
<tr>
<td>Upwards: Or (true if any sub-tasks are true)</td>
<td></td>
<td>If any property values have been entered, the values are cascaded and compiled upwards</td>
</tr>
<tr>
<td>Upwards: And (true if all sub-tasks are true)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Upwards: First sub-task' value</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Upwards: Last sub-task” value</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Note:** The cascaded values can be used in formulas, but formula results cannot be cascaded.

---

1 “The first sub-task” is the task in any group of tasks at the same level that has the lowest task number. E.g. in the sub-tasks of task 1.1 are 1.1.1, .1.1.2 and 1.1.3. The first sub-task is 1.1.1
2 “The last sub-task” is the task in any group of tasks at the same level that has the highest task number. E.g. in the sub-tasks of task 1.1 are 1.1.1, .1.1.2 and 1.1.3. The first sub-task is 1.1.3
<table>
<thead>
<tr>
<th>Property type</th>
<th>Cascade types currently available</th>
</tr>
</thead>
<tbody>
<tr>
<td>Single and multiple</td>
<td>Downwards, value of parent task&lt;br&gt;Upwards: Or (true if any sub-tasks are true)&lt;br&gt;Upwards: And (true if all sub-tasks are true)&lt;br&gt;Upwards: First sub-task value&lt;br&gt;Upwards: Last sub-task value</td>
</tr>
<tr>
<td>selection properties</td>
<td></td>
</tr>
<tr>
<td>Numeric properties</td>
<td>Downwards: value of parent task&lt;br&gt;Upwards: Sum of sub-task values&lt;br&gt;Upwards: Average of sub-task values&lt;br&gt;Upwards: Product of sub-task values&lt;br&gt;Upwards: Maximum (highest sub-task value)&lt;br&gt;Upwards: Minimum (lowest sub-task value)&lt;br&gt;Upwards: First sub-task value&lt;br&gt;Upwards: Last sub-task value</td>
</tr>
<tr>
<td>Rating scale</td>
<td>Downwards: value of parent task&lt;br&gt;Upwards: Sum of sub-task values&lt;br&gt;Upwards: Average of sub-task values&lt;br&gt;Upwards: Product of sub-task values&lt;br&gt;Upwards: Maximum (highest sub-task value)&lt;br&gt;Upwards: Minimum (lowest sub-task value)&lt;br&gt;Upwards: First sub-task value&lt;br&gt;Upwards: Last sub-task value</td>
</tr>
<tr>
<td>Formula</td>
<td>N/A</td>
</tr>
<tr>
<td>Logical combination</td>
<td>N/A</td>
</tr>
<tr>
<td>Text</td>
<td>Downwards: value of parent task&lt;br&gt;Upwards: Maximum (highest sub-task value)&lt;br&gt;Upwards: Minimum (lowest sub-task value)&lt;br&gt;Upwards: Concatenate sub-task values&lt;br&gt;Upwards: First sub-task value&lt;br&gt;Upwards: Last sub-task value</td>
</tr>
<tr>
<td>Task reference</td>
<td>Downwards: value of parent task&lt;br&gt;Upwards: Or (true if any sub-tasks are true)&lt;br&gt;Upwards: And (true if all sub-tasks are true)&lt;br&gt;Upwards: First sub-task value&lt;br&gt;Upwards: Last sub-task value</td>
</tr>
<tr>
<td>Boolean</td>
<td>Downwards: value of parent task&lt;br&gt;Upwards: Or (true if any sub-tasks are true)&lt;br&gt;Upwards: And (true if all sub-tasks are true)&lt;br&gt;Upwards: First sub-task value&lt;br&gt;Upwards: Last sub-task value</td>
</tr>
<tr>
<td>Picture</td>
<td>Downwards: value of parent task&lt;br&gt;Upwards: First sub-task value&lt;br&gt;Upwards: Last sub-task value</td>
</tr>
<tr>
<td>URL</td>
<td>Downwards, value of parent task&lt;br&gt;Upwards: First sub-task value&lt;br&gt;Upwards: Last sub-task value</td>
</tr>
<tr>
<td>Hyperlink</td>
<td>Downwards: value of parent task&lt;br&gt;Upwards: First sub-task value&lt;br&gt;Upwards: Last sub-task value</td>
</tr>
</tbody>
</table>

As values are set by cascades they are indicated in the property columns in green. These values can be changed at any time by entering a property value manually. Values that have been entered manually are shown in black.
Analysis Templates

Templates can be defined to specify any properties and any pre-defined lists of property choices that the initial analysis file will contain. For instance, you can design a template about learning needs with properties called 'skill' and 'curriculum' and 'training medium' with appropriate multiple choice values predefined as well. Templates also contain any of the display options selected from the Options menu item (within the Edit menu). You can also load properties into your analysis from other TaskArchitect files at any time during the analysis – see Chapter 4.

To create a template:

In an existing or not yet started analysis, define the properties plus any lists of property values in selection lists and any display options that you want to see in your template file. Call the overall goal of the analysis – the first task in the Tabular View – the name that you would like to call the template.

Save the file

Find the file and change the file suffix from ta1 to ta0. The suffix can be changed by slowly clicking on the name of the file twice then editing the suffix. If the suffix is not being displayed, change the file display options in Windows by selecting Tools from the window toolbar, selecting Folder Options …, selecting the View tab, de-selecting ‘Hide extensions for known file types’, then clicking on OK. Copy this template file to the ‘templates’ folder in the ‘TaskArchitect folder where you originally installed the software. This will normally be within the ‘Program files’ folder on your hard disk.

**Note:** The template that you have created will appear in the Wizard with the same name as the first task in the file, not the name that you gave to the file.

**Note:** If you update TaskArchitect this folder will not be changed

**Note:** If you decide to delete the TaskArchitect folder, remember to take a copy of any template files that you want to keep.

If you would like to have further customized templates, for instance logos for the top of report pages, custom box layout with properties shown in the boxes contact support@TaskArchitect.com.
Chapter 6 – Creating plans

This section describes the following actions:

- Creating plans
- Creating plans using the graphical editor
- Creating simple plans
- Creating advanced plans
- Creating plans by writing them in full
- Deleting plans

Creating plans

Plans describe when sub-tasks are performed – the order they are performed in and the conditions that trigger their performance. When all of the necessary sub-tasks of a task have been performed, the goal of the task will have been met.

There are two main ways of creating plans using TaskArchitect – by writing them out in full in plain English or by creating them a special plan editor. Writing them out in full makes it easier to capture tasks on-the-fly and to create complex plans with sophisticated logic such as loops. The Plan editor makes it easier to compose plans from pre-defined logical sequences and see the results displayed graphically. The plan editor makes it easier to ensure that all sub-tasks are included in the plan and that the plan is logically well expressed.

TaskArchitect automatically updates all plans after any changes to the task hierarchy, significantly reducing the amount of work required when editing the task analysis.

Plans can be specified for any task that has sub-tasks defined.

Plans can be a simple sequencing of the subtasks, or more advanced involving multiple plans that are initiated depending of the conditions (If … statements) that the user defines and multiple conditions within each plan.
Plans can show either the complete numbers of the subtasks or just the short form of the numbers. To switch between short form numbering and complete numbering in plans, from the View menu select ‘Show complete numbers in plans’.

For more information on how plans are used in task analysis, see the accompanying document ‘An Introduction to Task Analysis using TaskArchitect’

The Plan Editor is shown below:

![Plan Editor](image)

Creating plans using the graphical editor

The sub-tasks for the task whose plan is being edited are shown in the area at the left of the screen. By using the two drop-down lists on the right hand side of the screen the analyst can select the next steps to be performed (the Range) and the order in which they should be performed (the Task Order).

**Task Ranges**
The sub-tasks that can be compiled into a plan are listed down the left hand side of the plan editor and are numbered in order, as they are in the task hierarchy. The range can be a single task – ‘task 1’ or several tasks ‘tasks 1-4’. The range describes which tasks the Task Order applies to, for instance – do in sequence the range of tasks 1-4.

**Task Order**
The Task Order describes how the tasks are to be carried out, for instance ‘in sequence’ or ‘in parallel’ or ‘in any order’. The symbols in the graphical view of the plan show the logical relationship or order of the tasks.

Any of the following options can be selected for describing the Task Order:

Do in sequence
Do all of the range specified in the sequence that they are listed

Do all tasks in the range, in any order

Do all of the range, the order is not important

Do any one

Do any one in the range specified

Optionally do any

Do any number of tasks in the range specified

Do concurrently
Creating Simple Plans

TaskArchitect supports both simple plans, suited for most analyses, and more complex plans where several initiating conditions can be specified (allowing multiple plans per task) and conditions put in each task statement.

Plans can be specified for any task that has sub-tasks already defined.

To create a simple plan,

In Tabular View, click on any task that has sub-tasks defined.

Then either

Right click on the task number and using the menu select ‘Edit Plan’
or
From the main menu select ‘Plans’, then select ‘Add Plan’

The plan editor will be displayed for the task that you have selected, showing the tasks’ sub-tasks listed down the left hand side. By default, the plan editor shows a plan where all of the sub-tasks are carried out in sequence.

First select the order that the tasks should be carried out in using the drop down list, then select the range of tasks that the order applies to.

To apply the order to just a sub-set of the tasks, select the range that you wish to apply the order to. A new line in the plan will be created for the remaining sub-tasks. Specify another range and order for the next group of sub-tasks until you have described how all of the sub-tasks fit together. Notice that the plan is specified both as a diagram (at the right hand side of the screen) and as a written statement (at the bottom of the screen).

Ranges and orders can be combined to construct any plan required, for example — if the order of tasks required is ‘do 1, then do 2, 3 and 4 in parallel, TaskArchitect represents the plan as:

Do all of the sub-tasks in the range in parallel

Do not do

When this feature is used, neither a logical symbol nor the range of tasks are shown in the graphical view – because they should not be carried out. This is used to exclude sub-tasks from a particular plan.
Creating Advanced plans

Advanced plans allow the creation of:

- **Multiple plans per task.** Starting conditions for each plan is defined, with the default initiating conditions being 'In all cases' and for the next plan added 'Otherwise'. These allow you to add additional plans for the same group of sub-tasks if they are re-combined in different sequences depending on different starting conditions for the plan. For instance, a plan could be written to cover one order of tasks if it is raining and one order of sub-tasks if it is dry. Up to 6 plans can be created for each task. If your task analysis requires more than 6 plans per task, please contact support@TaskArchitect.com for assistance.

- **Branching conditions or ‘If … statements’.** These allow you to specify branches within each plan, depending on the either the results of previous sub-tasks or conditions that existed when the task was first started. For instance, for a plan covering the task of opening a valve, the first set of tasks might describe what to do to open the valve if the handle is present and the remainder of the task plan covers actions if the handle is not present.

Creating multiple plans per task

To create multiple plans per task:

- Put your cursor on a parent task. Plans can only be created for tasks that have sub-tasks.
- From the Plans menu, select either Add Plan or Edit Plans
- When the Plan Editor is displayed, select the type of plan that you want to create – in this case 'Advanced plan with conditions'.

The Plan Editor will look similar to this:
Either add a new initiating condition or change a condition by pressing Add or Delete.

You will be asked to specify the condition:

Type the name of the initiating condition e.g. If it’s raining.

The condition will be displayed in the list of conditions and in the description of the plan at the bottom of the Plan Editor:
Creating branching conditions

To create branching conditions:

Put your cursor on a parent task. Plans can only be created for tasks that have sub-tasks. From the Plans menu, select either Add Plan or Edit Plans.

When the Plan Editor is displayed, select the type of plan that you want to create – in this case ‘Advanced plan with conditions’.

The Plan Editor will look similar to this, showing a button containing ‘If…’ to the left of the first order drop-down list:

If you click on the ‘If …’ you will be able to specify the first branching condition. The condition should be written out in full – for instance ‘If it is raining then’, as this is the text that will be placed in the written description of the plan and the plan will be easier to read if you write clear, fully expressed clauses. If you use a shortened version of this text – for instance ‘raining’, this is the text that will be placed in the written plan, which may make it harder to read.
**Note:** When you do specify a branching condition a yellow diamond will be inserted into the graphical plan top show the location of the branch and the corresponding ‘If…’ button will contain a yellow diamond. The range of plans that the condition applies to will be indicated in the diagram by a yellow line. Where you do not specify a condition, although the order will have ‘If …’ written next to it, no condition will be specified.

Creating plans by writing them in full – freeform verbal plans

While the graphical plan editor makes it easy to create structured plans there are times early in an analysis project where it is more appropriate to write plans quickly in plain English – a freeform verbal plan. Freeform verbal plans also enable you to specify any plan logic you require, making it easier to create complex plans including loops and use of sub-tasks out of sequence which cannot be created using the graphical plan editor. For instance "Do 1-4 until the assembly is complete then do 1 again". As freeform verbal plans are typed any sub-task numbers are identified by the system and linked to the sub-tasks. This means that if the sub-task is moved, the system will recognise the change and notify you that the plan needs to be updated.

To create a freeform verbal plan, select ‘Freeform verbal plan’

Type the plan in the window at the top left of the plan editor. The finished plan is shown in the bottom of the editor. As sub-task numbers are typed (1, 2, 3 etc) they are linked to the sub-tasks and shown in the finished plan as numbers. Numbers that do not represent sub-tasks (If there are 4 sub-tasks but you type the number 5) they are represented in the plan as ‘***’.
Deleting plans

Any plans can be deleted using the ‘Delete Plan’ button at the bottom left of the Plan Editor.
Chapter 7 – Displaying the results of the analysis

In addition to the Tabular View of the task analysis, TaskArchitect provides alternative ways of visualizing the tasks analysis. This enables the analyst to see the relationships between the tasks from different perspectives and to create outputs that include those perspectives for incorporation into documents. It also enables the analyst to review and edit the tasks with end users in the most suitable way for the project being conducted. All tasks can be edited, moved, expanded and collapsed in the Tabular View, Left-Right View and Overview. The Cluster view is a different type of view – it is a means of arranging the task hierarchy so that it is easier to incorporate in reports.

There are 8 views of the task hierarchy available in TaskArchitect:

- Tabular View
- Left-Right View
- Overview
- Vertical Slice
- Form View

These are described below. In each of these views the task name can be automatically highlighted according to the property information that has been recorded for it.

The 6th view is a means of arranging tasks for printing:

- Page View

The 7th and 8th and 9th views are special reports – Timeline, Link and Map Location reports. Page View, Timeline, Link Analysis and Location Map are described in Chapter 8 – Using the results: Producing Reports and Exporting the analysis.
As described earlier, this provides a view of the analysis as an indented list of tasks and plans. Properties can be displayed in columns to the right of the tasks. Tasks can be added, moved and deleted.

In this view the tasks are laid out as a hierarchical diagram from left to right across the screen. Sub-tasks are to the right of tasks; tasks further down in the hierarchy are lower in the screen. Tasks that cannot be displayed within the current window are indicated at the margin of the screen to provide context for those that are displayed (context tasks). Plans are displayed below the parent task. The number of task levels that are shown can be selected using same method used for Tabular View.

Groups of sub-tasks can be collapsed and expanded as they are in the Tabular View and tasks can be cut/pasted/deleted and re-named just as easily.

Properties and plans can be accessed by right clicking on a task and selecting the appropriate item in the menu. Moving around the hierarchy is accomplished by using the keyboard arrows and the scrollbars.
Overview

This shows the tasks arranged in a vertical hierarchy, like an organizational diagram. The scale of the display, the ‘Zoom’ can be varied (from 100% to 5%, fit to width, fit to height) in order to adjust how much of the hierarchy is displayed in the window at once. This enables the analyst to see all of the hierarchy but little detail, or focus in on one small part of the hierarchy. This feature provides a ‘bird’s eye view’ of all of the tasks and allows large hierarchies to be copied and pasted into documents. Context tasks are shown when parent tasks are off page, in blue text on the diagram. Just as in the Left-Right View, groups of sub-tasks can be collapsed and expanded as they are in the Tabular View and tasks can be cut/pasted/deleted and re-named just as easily.
Vertical Slice

Vertical slice view enables the analyst to display the parents and children of a key task. The display shows all of the tasks directly above and below the last task that was clicked on (which is highlighted in yellow) - a vertical slice through the analysis. This is a very effective way of reviewing the analysis with subject matter experts – it compresses a very large hierarchy into just the tasks relevant for review of the target task. It’s also a very easy way of splitting your analysis into page size chunks. You may select to have the diagram drawn for paper (fixed size) or for screen (size varies according to the window size) using the drop down at the top left of the diagram. Sub-tasks are arranged vertically below the higher level tasks, just as they are in the Overview.

If there are more than 20 tasks in one of the levels being displayed TaskArchitect will limit the number of boxes in screen in order to make them easier to read. To display any boxes that are not currently on screen click on the last box that is displayed on the left or the right.
Form View

This is a type of tabular analysis. On the left is a list of the parents, siblings and children of the current tasks. The analyst can quickly move between tasks by clicking on any of these items. On the right hand side of the screen the details of the current task are shown:

- Task number
- Task name
- Plan(s)
- Whether the task is completed or stopped
- Unique task ID
- Date last changed, Name of the last person who changed it
- Task Properties

The amount of screen dedicated to each of these information items can be altered by dragging on the margin of the item.
Chapter 8 – Using the results: Producing Reports and Exporting the analysis

This section describes the following actions:

- Customizing the appearance of task diagrams
- Printing
- Grouping tasks for printing – Page View
- Exporting diagrams to Visio for final editing
- Report Generation
- Custom reports based on templates
- Exporting analyses
- Incorporation of results into other documents
- Sharing your work for review and comment

The diagrams in TaskArchitect have been carefully designed to meet the reporting needs of most analyses. In addition, aspects such as font colour, size and box size can be changed by using the Options in the Edit menu. The Overview and Left-Right and Page View diagrams can also be exported as graphics for easy sharing with other team members. Data from the Tabular View can also be exported for use in other programs such as Excel, Word and modeling programs. The Overview diagram can be further customised – annotations made and tasks re-positioned - through exporting the diagram to Microsoft Visio™ (2003 or later edition).

Since Overview Diagrams often span multiple printed pages, two features have been designed to help make this output easier to handle. Pages from printed Task Overview diagrams can be easily be re-assembled into larger diagrams using the option to add registration marks at the corners of the printed page. In order to make it easier to incorporate tasks from the Overview into reports, the Page View splits the task hierarchy automatically onto different pages. This unique feature means that very wide task hierarchies no longer need to be painstakingly assembled out of multiple pages, they can be broken up and printed according to how you want to communicate the information.

A number of pre-prepared reports on the contents of the analysis are provided. These enable the rapid production of tables of information from the diagrams that are suitable for incorporation into
analysis reports. The tasks to be included in the reports can be selected according to whether they are currently shown in the task diagrams (“expanded”) or according to the task property values (e.g. only those tasks where difficulty = high). The number of tasks per page, the task properties to be included and the headers/footers are all areas where the report can be customized. Report templates can be applied to the Page per Task reports in order to customize exactly how the report looks.

The export of information from TaskArchitect has been made as easy and flexible as possible in order to enable the tool to be used as a front end to more complex analysis tools. Export in XML, tab-delimited and comma-delimited text makes the output compatible with many applications. Contact support@TaskArchitect.com if you would like to learn more about integrating TaskArchitect with other tools.

At the end of this chapter guidance is provided on how to incorporate the results of your analysis into common office applications.

**Customizing the appearance of task diagrams**

The appearance of a diagram on screen is how it will look when printed. This includes whether or not context tasks are shown. The following aspects of diagrams can be changed using the Options dialogue, which can be opened by selecting from the Edit menu ‘Options’.

![Options dialogue](image)

Context tasks (the tasks at the edge of the diagram that indicate the tasks that cannot be seen on screen at the moment) can be shown/hidden by selecting from the View Menu the item ‘Context tasks’.

![Context tasks](image)
Printing

Each of the task diagrams can be printed. Printing is carried out using the ‘Print’ and ‘Page setup’ dialogues in the File menu. The Page setup dialogue enables the printer, paper type, paper orientation (landscape or portrait) and print margins to be set. To see each page in Print Preview, click on the up and down arrows in next to the page number to move through the print-out. See the section above on Options in order to adjust the background colours and whether context tasks will be shown.

In the Tabular View, Print Preview provides additional means of customising the printout. Since Tabular View can contain many columns of information it is necessary to specify how much of a page should be dedicated to the task name and how many columns of task properties should be printed. To select what information is printed from tabular view, first select which columns should be adjacent to the task name by organising them on screen. This is carried out by using the menu item “Show tabular view property chooser” from the View menu (or double clicking on a property column title) then using the drop down to select which properties appear and their left-to-right order of appearance. Then decide how wide you want each column to be and change the column widths by dragging the divider between the columns. Finally, select Print Preview from the Print menu in order to select how much of the paper width is dedicated to the task names.

Select which properties to appear using “Show tabular view property chooser”

<table>
<thead>
<tr>
<th>1: Department Responsible</th>
<th>2: Estimated Time</th>
<th>3: Communicates with</th>
<th>4: Include in timeline</th>
<th>5: Communicates by</th>
<th>6: Wait for</th>
<th>7:</th>
<th>8:</th>
<th>9:</th>
</tr>
</thead>
</table>

Select how much space is allocated to the task names using Print Preview
There are several features designed to make it easier to produce assemble printed pages of large task diagrams. The first is the opportunity to expand or collapse groups of sub-tasks in order to limit the diagram to the information that needs to be communicated. Page breaks on the screen indicate where the printed pages will separate. Secondly, the tasks are automatically aligned in the Overview so that vertical page breaks do not pass through task boxes. In addition, registration marks can be printed on diagrams in order to make it easier to cut and re-assemble pages in order to reconstruct a diagram that has been printed over multiple pages. Registration marks show the corner of each diagram, where adjacent diagrams meet. This guides the cutting or folding of paper when assembling large printed diagrams.

To turn on or off registration marks, from the File menu select ‘Show registration marks on print outs’.

The Page view automatically places groups of sub-tasks on separate pages; the Page view is described in the previous chapter. If these features do not provide sufficient flexibility then the Overview diagram can be exported to Visio™ for detailed manipulation of the appearance of the task hierarchy prior to producing a final report.

Page View

This view automatically organises tasks across pages so that logical groups are printed on together. TaskArchitect arranges the tasks into page size pieces while keeping related parts of the hierarchy on the same page.
It uses a mixture of off-page connectors, staggered tasks, wrapping task levels across multiple lines and comb diagrams (vertical lists of tasks) according to the options selected. Diagrams can be placed at the top left corner of a page or centred horizontally, vertically or both in order to use white space appropriately. Diagrams can be printed, or exported to either html or to Visio™.

Off page connectors are triangles linking the top levels of the hierarchy to lower levels that are shown on other pages. Off page connectors can be either numbered or letter. The number or letter points to the page where the other tasks above or below can be found.

Staggering places alternate tasks at a lower level in the hierarchy in order to maximise the use of horizontal space.
Wrapping moves the tasks that cannot be fit on one line onto the line below.

Comb diagrams list sub-tasks vertically below the higher level task.

Each option can be selected individually or in combination, apart from wrapping which is carried out automatically. Options are set using the Options button on the toolbar.

To print the page views use the print function as normal. To export the Page view, from the File menu select Export Page View.

**Customizing task diagrams – Export to Visio™**

The diagrams in TaskArchitect have been designed to meet most needs. In those cases where additional customization is required the Overview diagram can be exported to Microsoft Visio™. This feature enables the addition of custom annotations, labels and re-arrangement of the tasks. TaskArchitect output is compatible with Visio™ 2003 edition and later editions..

To export to Visio, from the **File** menu select **Export diagram** ... Specify the file name and press OK. The file will be saved as a Visio XML file, which can be opened right away using Visio. The Visio™ file will include the task boxes linked together in the task hierarchy, with the task boxes coloured according to the task highlighting scheme that was being used when the file was exported.

Modifications to diagrams are normally only carried out at the end of an analysis stage, since diagrams that have been exported to Visio cannot be imported back into TaskArchitect.
Creation of electronic copies of the Overview, L-R and Page View Diagrams

The Overview, L-R and Page View diagrams can be saved as a graphic file. These can be used to communicate the results of your analysis by email to people who do not have a copy of TaskArchitect.

From the File menu select either ‘Export overview diagram’ or ‘Export left-right diagram’ or ‘Export Page View diagram’ then select the type of graphics format the file to save the file in. A dialogue enables the name of the graphics file to be created and the location where it will be saved. Enter the appropriate file name and file location then click ‘OK’.

Report Generation

TaskArchitect provides four different report formats:

- Outline table – a table consisting of all selected tasks and their properties
- Page-per-task table – a table for each selected task and its properties
- Left-right charts – screen shots of the left-right view split into separate graphics and stored in a single file
- Overview tree – screen shots of the overview view split into separate graphics and stored in a single file

Each of these is accessed from the Reports menu. Each report is an html file that can be cut and pasted into a report or inserted into a file in its entirety. The resolution of the graphical reports or charts is set in the Report dialogue.

Outline Table (Tabular Analysis)

This report generates a single table of all tasks and their task details including task properties and the author’s name and date of the last change made to the task analysis. By using the tabs in the report dialogue you can choose from the following options.

Which Tasks:
Include all tasks
Include all of the tasks that are shown expanded in the diagrams. The sub-tasks of any collapsed tasks (indicated by a + sign) will not be included in the report.
Filter tasks by property value; only include those tasks that meet the criteria that you have specified.
Up to three filters can be applied. These filters are ‘Or’ed together – this means that any tasks that meet the criteria of at least one of the filters is included.

The ordering of the tasks:
The original order – the order of the tasks in the hierarchy. The tasks can be listed without any leading indent, or indented to show their level in the hierarchy. For example task 1.1 will be further to the left than task 1.1.1 Sort the task by property - tasks will be grouped according to the value of the property selected

The task properties to be included in the table:
Use the drop down items to select the names of the properties and the order in which they will be included in the table

The Headers and footers for the table:
Details of the header and footer can be selected from the ‘Headers and Footers’ tab.

The headings for the columns in the table are set automatically according to the task details that you have chosen to report on.
For more flexibility in the appearance of the table, export the task analysis data to Excel then reformat its appearance as required – see ‘Export’ in the next chapter – ‘Chapter 8 – Maintain the task analysis’.

From the Report menu select Outline Report.
Use the Browse button to select where you would like the file saved and create an appropriate file name
Select the details that you would like to include in the report
Press OK

The file will be saved as pages in html format and can be opened with Windows Explorer, Netscape, Word or Excel.

Example of an outline report

<table>
<thead>
<tr>
<th>Task</th>
<th>Plan</th>
<th>Same as</th>
<th>Developer</th>
<th>File</th>
</tr>
</thead>
<tbody>
<tr>
<td>Implement Software</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>1 Design</td>
<td></td>
<td>Helen</td>
<td>Custom Report,l</td>
<td></td>
</tr>
<tr>
<td>2 Build</td>
<td></td>
<td>Dick</td>
<td></td>
<td></td>
</tr>
<tr>
<td>3 Debug</td>
<td>If all goes well [do in sequence 1-4] - otherwise keep repeating [do in sequence 1-3; 4]</td>
<td></td>
<td>Custom Report,l Report,l</td>
<td></td>
</tr>
<tr>
<td>3.1 Debug locally</td>
<td></td>
<td>Tim</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

For example, a report could be produced to show grouped all tasks carried out by a particular person (providing the property ‘person’ has been created) or all tasks that involve use of a particular tool. To group the tasks according to property details, select the option for sorting by property from the options on the left of the Outline Report dialogue, then select the property to be used in sorting from the drop down.

In addition, tasks can be indented according to their depth in the hierarchy or all displayed at the same level. Indent by task level is normally only used when the extra tabs inserted are required in order to import the data into another tool.

**Page-per-task table**
This report generates a table for each task, listing the task name the plan and all of its sub-tasks.

The same types of task filters, ordering, task details and headers and footers can be selected for the Page-per-task table as can be selected for the Outline table.

Example of a standard page-per-task table, created without using a template:
3 Debug

Same as Developer

File | Customer Report Internal Report Project History

If all goes well [do in sequence 1-4] otherwise keep repeating [do in sequence 1-3; 4]

1  Debug locally
2  Deploy to server
3  Test on server

Report templates

In addition, the format can follow the default provided by TaskArchitect or a custom template can be created. The default format is a simple table containing all of the task details for each task. The user template is an html template that specifies how the table looks, where task details are placed in the table and which task details are reported on. This provides a large amount of flexibility in the creation of reports.

From the Report menu select Page-per-task table.
Use the Browse button to select where you would like the file saved
Press OK

To create a template for the page-per-task report:
Create an html table with the titles and boxes required
Place the name of the task detail to be reported on in the relevant cell of the table within ‘[ ’ ]’ square brackets.

This is an example of a template:

![Task Number][Task]

<table>
<thead>
<tr>
<th>Equipment Used</th>
<th>Task Allocation</th>
<th>Delay possible</th>
</tr>
</thead>
<tbody>
<tr>
<td>[Task Description]</td>
<td>[Task Allocation (URL)]</td>
<td>[Delay possible]</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Assessment by Analysis Teams</th>
</tr>
</thead>
<tbody>
<tr>
<td>Team 1</td>
</tr>
<tr>
<td>Difficulty</td>
</tr>
<tr>
<td>Frequency</td>
</tr>
<tr>
<td>Dependencies</td>
</tr>
<tr>
<td>Severity Classification</td>
</tr>
</tbody>
</table>

This is the output created from the template:
### 1.1 Monitor aircraft in CTR

<table>
<thead>
<tr>
<th>Equipment Used:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Task Allocation:</td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td>Delay possible?:</td>
</tr>
</tbody>
</table>

#### Assessment by Analysis Teams

<table>
<thead>
<tr>
<th>Team 1</th>
<th>Team 2</th>
<th>Team 3</th>
<th>Consolidated</th>
</tr>
</thead>
<tbody>
<tr>
<td>Difficulty:</td>
<td>High (challenging) Medium requires concentration Low does not require full attention</td>
<td>High (challenging) Medium requires concentration Low does not require full attention</td>
<td>High (high traffic) Medium (low traffic) Varies with traffic</td>
</tr>
<tr>
<td>Frequency:</td>
<td>Continuous or several times per minute</td>
<td>Continuous or several times per minute Very high (several times per hour)</td>
<td>Continuous or very few minutes</td>
</tr>
<tr>
<td>Dependencies:</td>
<td>Difficulty depends on traffic</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Severity Classification:</td>
<td>SC1 (Accident)</td>
<td>SC1 (Accident)</td>
<td>SC1 (Accident)</td>
</tr>
</tbody>
</table>

This is the html behind the template:

```
<html>
<head>
<title>Demo of TAReporter by Task Architect Inc.</title>
</head>
<body>
<table cellspacing=0 width=100%>
<tr align=right rowspan=2 width=20%><h1>[Task Number]</h1></tr>
<tr><td colspan=2>[Task]</td></tr>
<tr><td colspan=2>[Task Description]</td></tr>
<tr><th>Equipment Used:</th><td>[Equipment Used]</td></tr>
<tr><th>Task Allocation</th><td>Old:</td></tr>
<tr><td>[Task Allocation (old)]</td></tr>
<tr><th>New:</th><td>[Task Allocation (new)]</td></tr>
<tr><th>Delay possible?:</th><td>[Delay possible?] </td></tr>
</tbody></table>
</body>
```
### Assessment by Analysis Teams

<table>
<thead>
<tr>
<th>Difficulty</th>
<th>Team 1</th>
<th>Team 2</th>
<th>Team 3</th>
<th>Consolidated</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Frequency</th>
<th>Team 1</th>
<th>Team 2</th>
<th>Team 3</th>
<th>Consolidated</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Dependencies</th>
<th>Team 1</th>
<th>Team 2</th>
<th>Team 3</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Severity Classification</th>
<th>Team 1</th>
<th>Team 2</th>
<th>Team 3</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
**Left-right charts**

This function produces a report in the same format as the Left-Right view screen. Tasks are arranged hierarchically from left to right across the report. The size of the report is set in the dialogue – from 640X480 pixels to 1024X768 pixels. The graphic size sets the size of graphics that the report will be broken up into. These can be thought of as screen shots of the left-right view screens.

NOTE – To prevent context tasks from being shown in the task turn them off using the View menu.

From the Report Menu select **Left-right charts**.
Use the Browse button to select where you would like the file saved
Press **OK**

![Left-right Report](image)

**Example of a left-right chart report**

![Example of a left-right chart report](image)

**Overview tree**

Overview tree reports are the same as the screens produced by the Overview view. Tasks are arranged hierarchically from top to bottom of the screen. Just like the left-right charts, the size of the screen-shots produced is set in the report dialogue – from 640X480 pixels to 1024X768 pixels.

From the Report menu select **Overview tree**.
Use the Browse button to select where you would like the file saved
Press **OK**
Example of an overview tree report:

Exporting analyses

TaskArchitect was designed to provide easy integration with other tools. While the report features allows easy incorporation of parts of the analysis into documents, complete files can also be imported and exported. One of the most common forms of export is to Visio; for more information on this feature see ‘Sharing your work for review and comment’ below. TaskArchitect is compatible with Visio 2003.

TaskArchitect files are normally stored in XML format. Files can also be exported in comma-separated text format or tab-delimited text format. Microsoft Excel files are stored in comma-separated text format, so exporting data to Excel for further analysis is easy. Similarly, TaskArchitect files can be exported to databases such as Microsoft Access and other analysis tools. Contact
support@TaskArchitect.com if you would like to learn more about integrating TaskArchitect with other tools.

Any of the details of the analysis can be selectively exported to a file – from the task names, numbers and plans to properties and details of who last edited a task.

Steps to export information

From the File menu select Export:
Select the file format that you would like to export in,
Select the tasks to be exported and the order in which the tasks should be sorted for export. ‘Original order’ and ‘Indented by task level’ will ensure that the exported file matches the structure you are familiar with in TaskArchitect,
Select the task details that you would like to export,
Press OK

Incorporation of results into other documents

The incorporation of the results of your analysis into Word and Excel has been simplified: Vertical Slice and Single task diagrams enable all of the parts of the hierarchy to be quickly broken into separate meaningful diagrams that fit on a single page. Text based report formats such as Page-per-task and Outline table enable tabular analyses to be created out of the analysis and quickly imported into standard reports. Where a single larger Overview diagram is required, TaskArchitect arranges the analysis into pages so that the page breaks do not cut through text, making it easy to assemble the complete analysis.

Incorporation of exported data into Excel

In order to make importing data from TaskArchitect into Excel as easy as possible, ensure that the data is exported as comma-separated-values. The file will appear as a comma-separated values text file and will look like an Excel file. In order to open the data in Excel simply open Excel then open the file.

You may want to change the size of columns or the alignment of data in order to make the data appear exactly as you want to see it.

Incorporation of Outline Reports and Page per Task Tables into Excel

Since these reports are saved in a format (HTML) that Excel can read, these files can be opened in any of the following ways:
Right click on the file and select from the list of items ‘Open with …’. If Excel does not appear in the list of options, you may need to then select ‘Choose Program …’ from the bottom of the list then choose Excel from the list of programs.
Open Excel and drag the report into the main worksheet window. The file will then open.
From within Excel, select from the ‘File’ menu ‘Open’ and select the report that you want to open. If the file name does not appear in the list of files, select ‘All Files’ under the ‘Files of type’ drop down at the bottom of the open file dialogue.

You may want to change the size of columns or the alignment of data in order to make the data appear exactly as you want to see it.

Incorporation of reports into Word
From within Word, select from the ‘File’ menu ‘Open’ and select the report that you want to open. If the file name does not appear in the list of files, select ‘All Files’ under the ‘Files of type’ drop down at the bottom of the open file dialogue.

Incorporation of exported data into Word
The easiest way to incorporate exported task analysis data into Word is to first import it into Excel. Once it is in Excel, re-arrange the columns of data as required, copy the columns of data that your need and paste into Word as formatted text (RTF). To paste as formatted text, from the Edit menu select Paste Special … then select the formatted text (RTF) option. You may want to change the size of columns or the alignment of data in order to make the data appear exactly as you want to see it.

Alternatively, the exported data file can be opened from within Word and formatted using the Convert Text to Table Command. To do this, select Open file from the File menu and select the file type ‘All Files’; select the exported file that you want to open and click OK. When the file has opened the text will appear to be unformatted. To convert it to a table, select all of the text then from the Table Menu select ‘Convert text to table …’ and when requested set the value for ‘Separate Text’ to be ‘Tabs’.

Incorporation of diagrams into documents
Hierarchical task analysis diagrams are often very wide documents – wider than most printers can print on a single page. This is why the vertical slice and single task views were designed – to provide a way of breaking the hierarchy up into meaningful pieces that could be printed on single pages.

It can also be useful to provide a single diagram of the hierarchy – the Overview diagram. Since this is normally far wider than a single page, and scaled down versions can be hard to print there are three options for incorporating a meaningful version of the diagram in a document. The first is to print the diagram and assemble the pages. TaskArchitect arrange tasks in the Overview so that when they are printed no boxes or plans are cut across pages. This makes it far easier to assemble a diagram from multiple sheets. The Cluster View is designed to help you to arrange the pieces of a large diagram onto separate pages. The third option is to produce an Overview Report, open it with Excel and assemble the screen shots produced into a seamless diagram. Any page formatting – page numbers, titles etc in the main report can then be added so that it fits the style of the rest of the document.

Sharing your work for review and comment
The free trial version of TaskArchitect also opens all TaskArchitect files - it acts like Adobe Reader™. This enables files to be shared across teams without all of the reviewers needing to purchase TaskArchitect. The free trial opens all TaskArchitect files and displays and enables printing of all diagrams and reports. Reviewers can also edit the last property in the file, so if this is defined as a text property the reviewer can add and save comments about tasks.

All of the diagrams and reports created with TaskArchitect can be saved electronically and sent to reviewers. Where written comments are required electronically on the diagrams, one approach is to print them using Microsoft Document Imaging (part of Microsoft Office 2003). This creates a file of the printout that can be sent to reviewers for annotation.
The Overview of the analysis can be saved as a picture, for easy distribution to reviewers. To save an Overview, from the File menu select ‘Export Diagram’ and from the file selection drop down under the file name select from Visio (2003), CompuServe GIF pictures (.gif), jpeg picture (.jpeg) or Windows Bitmaps (bmp).
Chapter 9 – Special reports: Link tables, Timeline and Location Map

Link Tables, Timelines and Location Map allow considerable manipulation of the data driving the diagram in order to produce focussed reports. Link Tables show how task property values coincide, how parts of the environment or people interact with each other during the tasks, while Timelines show how tasks are related in time - how they fit together in sequence. Location Map shows how tasks are related in space - where they occur in the workspace, the frequency of use of these locations and show the movement between these locations by different workers.

**Link tables**

Link tables allow the relationship between different property values to be calculated and displayed. For instance, in an analysis that records the communications between roles and the media used for those communications, the number of communications between each role can be shown, as can the use of different media by each.

<table>
<thead>
<tr>
<th>From...</th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Captain</td>
<td>Navigator</td>
<td>Pilot</td>
<td>Warrant Officer</td>
<td>Purser</td>
<td>Cargo Chief</td>
</tr>
<tr>
<td>Captain</td>
<td>0</td>
<td>2</td>
<td>1</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Navigator</td>
<td>1</td>
<td>0</td>
<td>1</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Pilot</td>
<td>1</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Purser</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>1</td>
<td>0</td>
</tr>
<tr>
<td>Engineer</td>
<td>0</td>
<td>2</td>
<td>2</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Officer of the...</td>
<td>6</td>
<td>6</td>
<td>5</td>
<td>5</td>
<td>6</td>
</tr>
</tbody>
</table>
Other examples of analyses using link calculations are the number of presses on a particular button - totals for each button and totals for each role; the risks encountered by each operator and frequency of a given risk. For a link table to be created the analysis must contain at least two multiple selection properties. The results can be printed or exported to html or as raw data for further calculations to be performed.

**Timeline**

The Timeline report shows the relationship between tasks over time - when they are conducted and how they fit together in a sequence. This feature lays out all the tasks on a time scale, calculated from the duration of each task. For team tasks, each member of the team is shown in a separate timeline (a ‘swimlane’), so that the analyst can see how efforts are coordinated and where communication is needed. It shows the start time and duration for each task selected to be in the report and for each role selected to be in the report. ‘Follows’ can be set so that one task does not start before another. The Timeline report can also show communications between each role.

For all but the simplest analyses there will be several scenarios for how a goal (top level task) can be completed, dependent upon the operator’s decisions, the availability of particular subsystems, the nature of the initiating event or the general operating conditions. For example, the tasks required to
deal with a leak could depend upon the size of the leak, the availability of other systems, the system conditions when the leak occurred, or the strategy adopted by the operator etc.

TaskArchitect timelines show one particular scenario, according to the tasks selected, rather than all possible scenarios. For each scenario the analyst must then select the relevant subtasks to be shown. Plans are not used to draw the timelines, all tasks selected to be in the timeline occur in sequence – their spacing and relationships are dependent on the position of the task in the hierarchy, duration of the tasks and any ‘follows’ indicated by using task references to show which tasks follow another.

The timeline feature requires a number of specific pieces of information about each task, so that the timing and interactions between tasks can be identified. Before identifying the specific settings, it is important to understand the distinction between a conventional task analysis and one which has been set up with timelines in mind. A normal task analysis captures all the variations in how tasks are sequenced, recording (using ‘plans’) the order of tasks under different conditions, and showing where operators can choose the order of task performance. This kind of detail is very important in a comprehensive task analysis, but it is not possible to capture it in timeline form.

The aim in building a timeline should be to capture a specific scenario, in which tasks are done in a particular order. The choice of scenario depends on the purpose of doing the timeline; it might be a typical scenario, or an extreme one designed to highlight risk areas.

Because the plans feature is designed to capture complex dynamics, it is not used in timeline specification. Here, tasks are assigned to ‘roles’ – usually individual team members – and it is assumed that all tasks proceed concurrently, as long as each team member has completed any previous task. To account for places where one role has to wait until another has completed a task, ‘wait’ conditions can be added.

The easiest way to learn to use the timeline function is to create a simple analysis with the properties for the duration of the tasks and the roles that are carried out, to see how these are displayed, then gradually increase the complexity of the analysis by adding properties to indicate which tasks follow one another and when communication is required.

- The information used to draw a Timeline is: The property that contains the timing information - the Duration,
- The tasks identified to be included in the analysis - the Filter,
- The roles identified to be included - the Role, usually a job title for the person performing the task,
- The property used to indicate communication between roles (or any other relationship, but generally called - Communicates, and
- The property used to indicate if one task must be completed before another starts – Follows.

For instance, in this timeline the duration used is the Duration property ‘Estimated time’, the Filter is a Boolean property called ‘Include in timeline’, the role plotted is the values in the multiple choice property ‘Department Responsible’, communication between tasks is captured in the multiple choice property ‘Communicates with’ and if a task follows another this is indicated in a Task Reference property called ‘Wait for’.
The timeline shows the tasks selected to be included in the analysis (Filter), in vertical (or horizontal, depending on the Format selected) columns under each Role - in this case the department responsible for the task. The duration of each task is represented by the length of the box drawn; this feature can be turned off and constant box sizes shown at the start point for each task by checking the ‘Fixed box size’ field.

The scale of the diagram is set according to the number of seconds/minutes/hours per unit of length, and is set in the Scale box of the options. If a task cannot be fit on the timeline at the place where it would start a thin blue line is drawn from the correct location on the scale to the task box.

Navigate through the diagram by selecting the page to show, using the up/down arrows at the top right of the diagram.

Communication between roles during a task is illustrated by a red joining line with circles identifying each role that is communicated to.
Concurrency between tasks means that they can occur at the same time. This can only happen when the roles performing them are independent – different people or organizations perform the tasks and can perform them at the same times. When 'Allow concurrency where roles are independent' is checked, tasks that start at the same time will be shown on the diagram in parallel to each other'. When this feature is turned off, the tasks are displayed serially – the task with the lower task number must be completed before the next task will be drawn. For instance, the diagram below shows tasks occurring concurrently.

This diagram shows the tasks displayed serially.
The item 'Lane order' in the tab 'Roles to include' can be used to change the display of the roles from the order they were defined in and appear in property definitions, to the order they need to be displayed for this analysis in the timeline.

All diagrams can be printed and exported to Visio™ or html files or exported as a graphic. The scale used to draw the diagram and the size of the paper can be adjusted in the display options. Always click on OK after adjusting the scale. The graphic size can be set to a particular paper size or adjusted to fit the paper selected for the printer.

**Timeline - Role Property**

In order to create a timeline, the file must include a number of property variables which have specific meaning in the timeline. The first of these is the 'role' property. Create a 'selection list' property with the 'multiple choice' option, and add a choice for each of the team members involved in the scenario.

As in the example, it is useful to apply a 'down' cascade to this property, so that subtasks are automatically assigned the role of the parent task, unless the analyst chooses otherwise. In the analysis, assign each task to the appropriate role. If more than one person is needed to complete the task, record this by checking more than one role.
It is important to be clear in assigning roles, to ensure that only primary participants are included.

Tasks proceed in the timeline scenario, as long as the person performing the role is not performing some earlier task. In the example above, task 1.4.2 cannot proceed until the captain is available, and the captain cannot proceed with other tasks until 1.4.3 is completed. However, 1.4.1 can start before 1.3.3 is completed, because there is no overlap in roles between the tasks.

Note that the plans shown here do not affect the timeline; although the plan specifies that 1.4.1 and 1.4.2 are concurrent, they will be shown sequentially in the timeline because the Navigator is involved in both tasks.

Only the lowest level of tasks are considered in the timeline. In the example above, 1.4 has been assigned to the captain, but that does not prevent 1.4.1 for proceeding concurrently with 1.3.3. Any task which is broken down into sub-tasks is ignored when creating the timeline.

**Timeline - Duration Property**

In order for the timeline to produce reasonable results, the duration of each task needs to be estimated. Create a property of the type ‘duration’, and choose a format for the display of the values. Times are stored internally as seconds in TaskArchitect, independent of the format.

It is useful to apply the cascading logic ‘upwards: sum’ to this property, so that total times for tasks can be inferred where the sub-tasks are sequential. However, it is important to note that this may not correspond to the total time in the timeline; if any of the subtasks are assigned to different roles, they will proceed concurrently in the timeline.

Once defined, a time needs to be entered against each task to be included in the timeline.
Again, upper-level tasks are ignored, so a duration applied to a parent task will not affect the duration of the subtasks. In the timeline, the higher-level task is considered complete when all of its subtasks are complete.

It may be useful to assign a number of different durations to each task, for some types of analysis, such as a ‘typical’ or a ‘worst case’ duration. The timeline can be quickly switched from one duration property to another, to see how this affects the sequence.

**Timeline - Follows Property**

In most scenarios, there are some overriding conditions which prevent tasks from proceeding until another task has been completed. Until the crane is set up on a construction site, nothing involving moving materials can go ahead. To handle this type of dependency, the TaskArchitect timeline includes a ‘follows’ property.

Define a property of the type ‘task reference’, with the ‘allow multiple’ option checked, so that a single task may wait on a number of others.

In the task file, assign this property with a reference to any task which must be completed before the present task can go ahead.

<table>
<thead>
<tr>
<th>Task</th>
<th>Start Time</th>
<th>Duration</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.3.3 Choose launch window</td>
<td></td>
<td></td>
</tr>
<tr>
<td>1.4 Develop flight plan 1-2</td>
<td>do concurrently 1-3</td>
<td></td>
</tr>
<tr>
<td>1.4.1 Develop alternate plans</td>
<td></td>
<td></td>
</tr>
<tr>
<td>1.4.2 Identify priorities</td>
<td></td>
<td></td>
</tr>
<tr>
<td>1.4.3 Negotiate final plan with station control</td>
<td></td>
<td></td>
</tr>
<tr>
<td>2 Announce departure time</td>
<td></td>
<td></td>
</tr>
<tr>
<td>3 Make ready 1-7</td>
<td>do concurrently 1-8</td>
<td></td>
</tr>
<tr>
<td>3.1 Secure cargo area</td>
<td>do in sequence 1-2</td>
<td></td>
</tr>
<tr>
<td>3.1.1 Decide final cargo manifest</td>
<td></td>
<td></td>
</tr>
<tr>
<td>3.1.2 Notify bridge of mass</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Captain</td>
<td>0:00:30&quot;</td>
<td></td>
</tr>
<tr>
<td>Captain</td>
<td>0:20:00&quot;</td>
<td></td>
</tr>
<tr>
<td>Navigator, Pilot</td>
<td>0:10:00&quot;</td>
<td></td>
</tr>
<tr>
<td>Captain, Navigator</td>
<td>0:05:00&quot;</td>
<td></td>
</tr>
<tr>
<td>Captain</td>
<td>0:05:00&quot;</td>
<td></td>
</tr>
<tr>
<td>Officer of the day</td>
<td>0:00:20&quot;</td>
<td></td>
</tr>
<tr>
<td>Captain</td>
<td>1:34:30&quot;</td>
<td></td>
</tr>
<tr>
<td>Cargo Chief</td>
<td>0:11:50&quot;</td>
<td></td>
</tr>
<tr>
<td>Cargo Chief</td>
<td>0:02:00&quot;</td>
<td></td>
</tr>
<tr>
<td>Cargo Chief</td>
<td>0:00:10&quot;</td>
<td></td>
</tr>
</tbody>
</table>
In this scenario, 4.1.4 is marked as ‘waiting for’ 4.1.3.3, so that the pilot does not launch the ship into space until the engineer has certified that the jets are working. In normal timeline logic, these tasks would proceed concurrently because they are performed by different roles. In addition, 4.1.3.3 is marked as waiting for 4.1.2, so that the engineer does not imply the ship is ready to go before the officer of the day has authorised it.

In setting up ‘wait for’ conditions, it is important to remember that only tasks with no sub-tasks are considered in the timeline. In the example, 4.1.4 is shown as dependent on 4.1.3.3, not its parent 4.13, because the latter does not appear in the timeline.

Another example of this is seen in our illustration, where the captain is made responsible for collecting readiness reports from each of the departments and announcing readiness for departure.

Each of the ‘obtain reports’ tasks depends on a different branch of preparations being completed. Placing ‘call out ready’ after these in the same role keeps them sequential, and making the subsequent ‘detach from station’ task dependent on the announcement keeps everything in sequence.

Although higher-level tasks are not included in the timeline, creating a wait condition prevents sub-tasks from proceeding. In this case, all of the subtasks of ‘detach from station’ must wait until 3.8.6 is completed, because of the wait state set up on 4.

**Timeline - Filter Property**

Task analyses are seldom created purely to get a timeline diagram. More complex plans and conditions need to be captured, and there are often tasks included in a broader analysis which do not fit into a timeline. To account for this, create a Boolean property.
It is useful to use the ‘down’ cascade type, so that excluding a parent automatically excludes any subtasks. Our sci-fi example does not use this attribute (it really was created just to make a timeline), but real-world analyses include tasks like ‘monitor controls and respond to emergencies’, or ‘watch children and break up fights’ which naturally occur concurrently with other tasks, and should be excluded. An analysis may also include a level of detail which is too deep for a timeline. In either case, un-checking the ‘include’ property can be used to filter out these tasks.

**Timeline - Communicates property**

As well as showing the sequence of tasks, the timeline can show where the performance of one task causes communication with another. This is set up in a similar way to the ‘role’ property.
It may be useful to include additional players in the ‘communicates with’ property, such as the ‘station’ and ‘passengers’ shown here. However, these will not show up in the timeline, which has a lane only for each of the roles.

Assign the ‘communicates with’ property to all the parties who need to receive information from the person performing the task.

It is useful to consider a ‘communicates with’ link for any task which is a subject of a ‘wait for’ link, or vice versa. It is often the case that a person performing a task needs to communicate its completion to anyone whose next step depends on it.

**Timeline - Building a Timeline**

**Choice of Properties**

Choose ‘Timeline Report’ from the ‘reports’ menu, and identify the properties to be used in the timeline.

![Timeline Report](image)

All of the properties are optional except ‘duration’, but it is recommended that all the properties be specified. To work correctly, ‘role’ and ‘communicates’ should be multiple-choice selection lists; ‘filter’ should be Boolean; ‘follows’ should be a multiple-reference property, and duration has its own special type.

Note that a TaskArchitect file can include more than one ‘duration’ or ‘filter’ property, allowing different scenarios to be explored by switching between them to produce different timeline diagrams.

**Display Options**

On the display tab, choose the options needed to provide a reasonable display.
The preferred **format** will depend on the length of the task names: longer labels are more readable in the horizontal format, especially if there is a large number of roles. The **fixed box size** should normally be off; it is useful if the task durations are very variable, but the resulting diagram is less clear.

If the purpose of generating the chart is for printing or for inclusion in printer-sized pages in a report, the **graphic size** should be set to ‘same as printer’. If the intention is to export a graphic to be printed elsewhere, a larger diagram size is recommended, such as A1 or even A0. For a diagram which fits a single graphic file, choose ‘custom size’ and then click on the ‘size to fit’ button.

Note that this can result in a very large graphic, which may be too big to open in some applications. If the timeline is very large, it may not be possible to use the ‘size to fit’ option; choose a smaller scale if needed.

If a size other than ‘same as printer’ is chosen, the ‘print’ button is disabled, as a correct printout requires that the graphic size be the same as the printer paper. The diagram is usually divided into multiple pages, which can be accessed using the buttons on the right.

When a diagram spans more than one page, the pages do not necessarily follow on directly from one another. In order to avoid a diagram which is made up of many pages of blank bars, each page only starts when the next task transition occurs after the previous page. For example, if page 1 included only tasks which were several minutes long, page 2 would only commence when the first of these was...
completed. This keeps the diagram more concise and readable. If the analyst needs a graphic with large bands empty of task transitions, they should choose a larger graphic size. The scale should be chosen to match the level of granularity in the duration of the tasks. Assigning 5 sec/cm works well if the shortest tasks are about 10 seconds, for shorter tasks, assign a smaller number.

The allow concurrency where roles are independent checkbox should normally be on. Turning it off shows all the tasks in the sequence they are shown in the file, which will only work for a very simple analysis.

Roles to Include
In a typical analysis, there may be more roles than comfortably fit in a diagram. This tab allows the analyst to choose which ones to include. Note that excluding a role from the timeline excludes it from the logic of sequencing tasks. In order for all tasks to be considered in laying out the timeline, all the roles should be included.

If preferred, clicking on Lane Order allows roles to be included in a different order to their presentation in the file. Once this option is selected, the checkboxes are not shown in the main window until it is closed and re-opened.

Timeline - Task Details
In order to speed up adjustment of the task analysis, the selected task properties can be altered directly in the Timeline window.
Select a task by clicking in the timeline itself, and relevant properties will be shown in the task details area.

Note that changing the ‘role’ or ‘filter’ properties can exclude the task from the diagram; in this case it can only be restored by closing the timeline and adjusting the properties in the main window.

It is important to keep cascading in mind when altering properties in this window. If the role or filter property have been assigned a ‘down’ cascade, deselecting them in this window will result in them inheriting the value from their parent task. As a result, turning off a role here may not remove the associated task from the timeline. If this is a problem, it may be overcome by removing the cascading (in ‘define properties’) or by creating a role called ‘nobody’. Excluding ‘nobody’ from the timeline will make sure that it is not displayed, but checking ‘nobody’ and unchecking all other roles will remove the task from the timeline, overriding the cascade effect.

**Timeline - Print and Export**
Choosing the **print** option will simply print the entire file. This option only works if the graphic size is set to ‘same as printer’.
• **Export HTML** results in a web page which includes each page as a graphic. This is stored in two formats, an HTML file with a folder of associated graphics, and an MHT ‘web archive’ format which combines the web page and the graphic into one. While the latter format is more convenient, it can only be opened in Internet Explorer.

• **Export to Visio** results in a ‘VDX’ file which can be opened by Microsoft Visio™ 2003 or later. This is a specialised version of XML developed by Microsoft for diagram interchange. Once in Visio the diagram may be customised as needed. Any changes made in Visio cannot be transferred back into TaskArchitect.

• **Export to Graphic** results in a bit-mapped graphic file, in GIF, JPG or PNG format for opening in a variety of programs. This may result in a very large file, which may not be compatible with all programs which normally accept graphic files, and may result in operating system errors on early versions of Windows. If the graphic size is smaller than the diagram, multiple graphic files will be produced, with numbers in the filenames to indicate the sequence. As in printing, no graphic will be produced for areas of the timeline where no task transition occurs.

• **Save** saves the whole TaskArchitect file, including any unsaved changes which occurred before the timeline window was opened.

• **Close** closes the timeline window and returns to the main window without saving the file. If you need to close the file without saving changes (e.g. in the case of a major error), click on close and then close the application, and answer ‘no’ when prompted to save the file. Note that any changes made before opening the timeline window will be lost in this case.

**Timeline - Interpretation**

This diagram illustrates some of the special features of TaskArchitect timelines.
The arrows show the communication between tasks, with black dots indicating the role(s) performing the task, and arrows pointing in to each of the lanes receiving the message.

The colours of the boxes can represent any property which is useful to the analysis, such as risk levels, degrees of confidence and so on. This is controlled by task highlighting, which is documented elsewhere. It can control the text style or the colour of the box, its outline and the text within it. The special box shapes are not recommended for highlighting in the timeline, as they become distorted by the length of the bars.

The yellow outlines on 1.4.1 in the illustration indicate selection, and do not appear in exported graphics or printouts.

**Timeline - Advanced Issues**

**Task Sequencing (simple case)**

In order to understand how tasks are sequenced, it is important to first look at the default logic, where there is no 'follows' property and the structure and the role determine the outcome.

In the example shown here, roles and durations have been assigned more or less at random.
This results in the following timeline:

<table>
<thead>
<tr>
<th>Time</th>
<th>00&quot;</th>
<th>05&quot;</th>
<th>10&quot;</th>
<th>15&quot;</th>
<th>20&quot;</th>
<th>25&quot;</th>
<th>30&quot;</th>
</tr>
</thead>
<tbody>
<tr>
<td>Role A</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>2.1 two point one</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Role B</td>
<td>1.3 one point three</td>
<td>2.2.1 two two, 3.2 three point two</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

The assignment of role A to tasks 1 and 3 have been ignored, because these are not 'leaf nodes' – they have subtasks, and it does not make logical sense to assign roles and durations to non-leaf tasks.

A different assignment is shown here avoiding that issue

And this is the resulting timeline.

<table>
<thead>
<tr>
<th>Time</th>
<th>00&quot;</th>
<th>05&quot;</th>
<th>10&quot;</th>
<th>15&quot;</th>
<th>20&quot;</th>
<th>25&quot;</th>
<th>30&quot;</th>
</tr>
</thead>
<tbody>
<tr>
<td>Role A</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>1.1 one point one</td>
<td>2.1 two point one</td>
<td>3.1 three point one</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Role B</td>
<td>1.3 one point three</td>
<td>2.2.1 two two, 3.2 three point two</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

To understand this, you can think of all the leaf-nodes assigned to a particular role as a flat list, in the order they are shown in the tree but regardless of the nesting of one task inside another. In the absence of a 'follows' property or any overlapping roles, each role goes sequentially through its own list, independent of the other roles.
Task Sequencing (overlapping roles)
In a real task analysis, some tasks will be performed collaboratively, with more than one role involved. If we modify the above example so that 2.2.1 is performed by both roles

The timeline will now make Role A wait until Role B is ready to work on it.

Task dependencies should be recorded in this way as far as possible, without introducing a ‘follows’ property, as this method is more flexible and easier to maintain through changes in the task definition. Note that the tasks in each Role are always performed in the order they are listed – the timeline would not allow Role A to proceed with 3.1 while waiting for 2.2.1 to become ready, even if the task would fit in.

Task Sequencing (‘follows’ property)
Despite the name, the use of the ‘follows’ property does not always ensure that one task follows another. It is used to record a dependency, and a more complete name would be ‘must not precede’ or ‘must occur after’. As a result, a ‘forward reference’ from an earlier task to a later one is ignored.
The timeline is the same, because 1.3 cannot follow 2.2.1.

However, if the property is used to specify that 2.1 must follow 1.3 this does alter the timeline, introducing an additional wait state.
Location Map Report

The Location Map enables the display of information about where tasks are carried out on a ‘map’ with arrows representing the movement of workers across the area. It can also be used to represent hand movements in a workstation or movements of attention across user interface screens.

The map can be any picture - a screen shot of a user interface, a picture of a workplace or a geographical map of an area. In addition, the map can display the proportion of tasks carried out by each role at each location and the sequence of movements between the locations by each or all roles. The sequence of movements is determined by the order that tasks appear in the task analysis, the plan is not used to determine the sequence. The role (who carries out the task) can be defined using any selection list property. For example, it could be the person carrying out a task or their function. The location of where the task is carried out is defined by adding locations on the map in the Location Map report.

Location map reports can be printed or exported as a graphic.

An example of a location map report showing count of tasks for each role per location.
Creating a location map

In order to create a timeline, the file must include a number of property variables which have specific meaning in the timeline. The first of these is the ‘location’ property. In order to correctly assign each task to a place on the map, define a property of the type ‘map location’. This property is defined in the normal way, but values need not be assigned until the map is available.

<table>
<thead>
<tr>
<th>Property Type:</th>
<th>Property value cascade:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Map Location</td>
<td>(none)</td>
</tr>
</tbody>
</table>

Description:
The place where the task is carried out.

In the same way as for the timeline feature, the file must also include a ‘role’ property. Create a ‘selection list’ property with the ‘multiple choice’ option, and add a choice for each of the team members involved in the scenario.
As in the example, it is useful to apply a 'down' cascade to this property, so that subtasks are automatically assigned the role of the parent task, unless the analyst chooses otherwise. In the analysis, assign each task to the appropriate role. If more than one person is needed to complete the task, record this by checking more than one role.

It is important to be clear in assigning roles, to ensure that only primary participants are included. For the location map, only those roles which need to be physically in the same place need to be assigned to a task. If the task involves discussion among parties in different places, only the primary role should be assigned to the task.

**Choosing a Picture**

It is important that the background of a location map makes each location clear and separate. It might be a photograph of the task setting, as in our 'lock' example…
…an aerial photo or satellite view…

…the floor plan of a building…
In all cases, you may need to adjust the contrast levels on the graphic before you use it – using a program such as Adobe Photoshop™, use the ‘levels’ control and set the top and bottom output levels.
to medium and light greys. This will ensure that the location markers TaskArchitect adds to the diagram stand out from the background.

Defining a map
To start displaying a location map either from the Reports menu select 'location map' or from the toolbar click on the icon:

If the location property is not defined in advance the system will prompt and lead the user through the definitions.
The default property for the location that is defined by this dialogue is called "Location".

If a location map has not yet defined the user is taken to the screen for loading and describing it.

The Name of the location map is the name that the user chooses to be displayed while the location map is generated and altered. The Picture is the graphical map that locations are placed on - the user interface, control room, workplace etc. The Location property stores the values for the name of where the task is carried out and the co-ordinates for it on the map picture. The Role property defines what to associate with the location - a person, a task type, a role - it can be any multiple-selection type property. Type in a name for the map, choose the picture tile, and identify the two properties – the location property and the role property.

The colours determine the colours of the text for the location markers and the colours of the transitions between locations for different roles and the pie-chart for the count of tasks at each location for each role. Click on a coloured square to select a new colour.

Once the new map has been defined, click OK and the Location Map Report window will open (in this case a diagram of a control panel is being used)
The tabs at the top of the window is used to specify what is displayed on the location map - which map and how it appears, which locations, and how the location markers are used on the map. The tree on the left of the window is used to either allocate tasks to locations or to identify the first or last task to be displayed in a sequence of movements between locations. The map is displayed on the right of the screen; locations are placed here and sequences of movement and tasks counts are shown here. The top right contains the standard functions for a window - print, export graphic, save and close.

**Identifying Locations**
In the locations tab, click on the 'add new location' button, enter a name, and click on the diagram where the location should appear. A yellow circle appears when the location marker is added, and clicking on the diagram moves it to the selected place.
Repeat this process until all the task locations have been added to the map.

To move the location to a different place on the map click on the location marker then drag it to a new position. Alternatively the co-ordinates for the map can be altered by editing the numbers then clicking outside the co-ordinates box to enter the change.

**Setting task locations**

Once the markers have been added to the map, you need to connect the locations to the appropriate tasks. This can be done in either of two ways.

- **In the map**, you select a marker (so that it is highlighted in yellow), then use the tree control on the left labelled ‘tasks at this marker’ to locate the relevant task. The ‘+’ and ‘-’ icons control the visibility of the parts of the tree. Once the task is found, check the box next to its name, and the location is associated with that task.

- Alternatively, the location property for the tasks can be set in **the tabular view**. After closing the map, ensure that the location property is visible in the tabular view, by double-clicking on
the bar at the top of the table and choosing that property. The location property can then be set by clicking on that cell in the table and selecting the location from the drop-down list.

Whichever method is used, it is important to ensure that the role property has also been set correctly. Links will not appear in the location map unless both the location and the role have been set for the tasks.

Once you have completed these selections, choose ‘transitions – all tasks’ from the ‘format’ control on the ‘display’ tab, and the arrows will be added to the diagram, with a different colour for each of the roles.

**Display Options - showing markers, counts and transitions**

Now that the locations have been defined and linked to tasks the display can be configured to show the relationship between them. The display can show the location names only, the count of tasks per role at each location, and the transitions (sequence of movement between task location) for each or all roles either for all tasks, the ten transitions following from a particular task or the last ten tasks preceding a selected task.

**Format - Markers Only**
The default display shows only the markers indicating where the locations appear on the map. This view is useful for defining the locations.

To show just the task names, from the Display tab select the Format drop down item Markers only

**Format - Counts**
This format shows the number of tasks which occur at each location, broken down by the role. The size of the circle reflects the total number of tasks associated with the location, and the size of each pie slice shows the proportion of each role located there. The colours used to represent the roles can be changed in the map details tab and the key for the role colours is shown at the top left of the location map.
A location is only counted once for each task, regardless of the number of roles involved. For example, the smallest circles in the above diagram represents a single task appearing at that location: the location ‘canal above lock’ has only one task associated with it, but all three roles are present at the time the task occurs. The similar-sized ‘bottom gate crossing’ marker also represents a single task, but here it is performed by one role, the ‘Swabby 2’ operating the far side of the lock.

**Format – Transitions (all)**

Transitions show the sequence of movements between locations in the order that tasks appear in the task hierarchy. The information in plans is not used to generate the sequence; it is determined by the numerical order of the tasks in the task hierarchy. To manipulate the sequence of transitions between tasks change the order of the tasks in the task hierarchy.
This format shows the number of movements occurring as the tasks are performed. The arrows are coloured according to the roles, with a striped arrow where more than one role is involved. The number of movements is indicated by the width of the arrow and the number in the white square. Unlike in the previous case, each role is counted separately. The transition from ‘canal above lock’ to ‘landing above lock’ is shown with a ‘3’ in the example above; although only one task transition is involved, all three of the crew members are present at the time.

To display the transitions for all of the roles, from the Display options menu select the Format drop down item Transitions-all, and from the Role drop down select All roles. All of the transitions will be shown using black lines, arrows indicating the direction of transition. To show all transitions for just one role, from the Role drop down select the role that you wish to see. It will be displayed in the color set up in the Location Map details dialogue.

Format – transitions (from start to selected task)
Location maps are often fairly complex, and showing all transitions may obscure important details. This format allows the transitions to be shown up to a certain point in the scenario, hiding later movements.

Format – transitions (10 prior to selected task)
To further simplify the diagram, this format shows only the transitions involving the last 10 tasks, leading up to the selected task. This feature looks at the previous ten tasks regardless of the role settings; it is possible that it will not encounter any transitions in that range, and hence show no arrows.

Note that, in making these selections, the selection of a marker in the map(outlined in yellow) is independent of the selection of a task in the tree (highlighted in blue).
Zoom
The zoom control allows magnification of the image. Scrolling with the scroll bars or dragging with the hand cursor can be used to show a portion of the diagram. The arrows retain the same physical scale, so will appear narrower in relation to the picture, allowing a crowded area to be seen more clearly.

Displaying a Quantity
While the option "Counts" in the Display tab shows how many tasks are performed by each role at a given location, the sum of all values of a selected property at a given location can be displayed using the Quantity tab. For example, Quantity could be used to show the total time taken for each task at a given location, the total number of errors on tasks at a location or the total cost of the tasks carried out at a particular location. Quantity displays the sum an numeric property already defined in the
analysis. This can be displayed as a circle showing the relative magnitude of each of the sums at locations and/or a numeric total.

**Understanding Marker Labels**

In additions to the location names, which is the default way to label the markers, they can show the task counts, the location number, or the name of the first task which occurs at each location. The latter is most useful where the map represents a scenario such as the events leading up to an accident, where each location is typically involved in only one task.
The indication ‘+1’ or ‘+2’ shows the number of additional tasks associated with the location, besides the one identified.

**Multiple Maps**

For a number of reasons, it may be useful to show more than one location map in the same file. These may represent different views of the same scenario, such as a plan and elevation, or different scenarios in the same task analysis. In the canal lock example file, we have maps for two different types of lock, and for two-man or three-man operation.

**Locations and Markers**

Up to now, we have been using these two terms loosely, as if they meant the same thing. In considering multiple maps, it is important to distinguish between the two. A ‘location’ is a named
place, which may appear in any of the maps in the analysis. A ‘marker’ represents the placement of a location on a single map. For example, an analysis of several similar accidents might have a location named ‘collision’ – each map in the file would then have a different marker showing where the collision occurred in each accident. In our example file, nearly all the locations are linked with markers on all the maps, except that ‘far-side top gate’ does not appear on narrow locks, which only have one top gate.

Add New Location
Once multiple maps are considered, it is necessary to understand that the ‘add new location’ button is actually performing two actions. It asks for a name for the new location, and adds that location to the file, and it then adds a marker to the present map, showing where that location occurs. These actions are combined because that is what users generally want to do.

Add Marker for Existing Location
If locations have been identified on one map, it is likely that they will also appear on others. If the location already exists in another map, it can be added to the present one using this button. It is important not to create duplicate locations – if a logically equivalent location exists on several maps, it should be added once to the first map, and then additional markers added to the other maps.

Copy Map
Where two maps are very similar, as in our lock example, the best method is to create the first map, click on ‘copy map’ and then provide a name for the second map. The system will automatically copy all the markers from the first map onto the second. These can then be positioned on the second map. Because it is the locations which are linked to the tasks, not the markers, the task flow will be the same.

To make a copy of the current map, for instance for the purpose of illustrating the efficiencies gained by moving locations for tasks or changing role assignments, use the Copy map function in the Map tab. A copy of a location map can have a different name to the old map, has the same tasks and the same locations are present but the locations can be moved without affecting their position on the old map. In effect all of the locations have been copied from the previous map to the copy map.

Multiple Role Properties
A file can have more than one role property, and these can be used to derive different maps. In our example file, there is a role property for three-handed operation, and a different one for two-handed operation.
In the first case, the captain stays in the boat and lets the crew handle the lock, in the second, the captain gets out of the boat and operates one side. This can be used to explore the effect of different task allocations, drawing a map using one role property and then copying it and using a different one.

**Multiple Location Properties**
Similarly, a file can have more than one property variable of the type 'location map', and maps can use different properties. This can be used to explore a different assignment of tasks to workstations, or a different routing of personnel, for example to identify how to keep people away from a hazardous area. Note that ‘locations’ (named places) exist independently of ‘location properties’ (task properties which refer to locations). There is always a single set of locations in an analysis file.

All location maps can be printed and exported as graphic files.
Chapter 10 – Maintain the task analysis

This section of the manual focuses on features to help you collaborate with team members in conducting an analysis. This includes importing task analysis files that were not created using TaskArchitect and importing part or whole TaskArchitect files including properties that match the current file.

Components or complete TaskArchitect files can be linked together or imported, enabling very large analyses to be created and/or managed across teams of analysts. This can involve detaching/attaching tasks, importing part or all of a TaskArchitect file and making hyperlinks between tasks in files.

This chapter also describes the creation of template files, which are used to pre-define those properties and values that will be available for use at the start of the analysis.

Autosave is briefly described – this is the automatically created file that is saved as you use the program that will be available for recovery of your information if your computer breaks down at any time.

As analysis progresses the spelling of the task names can be checked. The analysis can also be checked against a list of analysis rules (for instance ‘no more than 7 sub-tasks per task), just like a grammar checker.

Collaboration Features

TaskArchitect contains the following features that help with collaboration:

- Keeps a record of when tasks were last edited and who last edited them
- Allows you to mark when tasks are stopped and when they are completed
- Each task is given a unique identifier
- Tasks may be detached, worked on by another analyst, and then re-attached to the main document.
- Templates can be defined that specify any properties and any pre-defined lists of property choices that the initial analysis file will contain.
**Recording when tasks were last edited**

The program tracks the name of the person who last edited a task – whether it is the task name or the task property that was changed. This information is shown in the Task Details window and in the Form View, and can be exported along with all of the other task information.

The name of the person who is carrying out the changes is based on the username and serial number supplied when the program is first installed. This information is also printed out on any diagrams created by TaskArchitect. To change the username after the program has been installed, from the Edit menu select ‘Options’ and change the name in the field at the bottom of the display.

**Marking when tasks are stopped and when they are completed**

These marks are used to indicate when enough analysis has been carried out to meet the needs of the project (i.e. a stopping rule has been applied and the task can be marked as stopped). When the analyst wants to mark that all of the work that needs to be carried out on a particular part of the analysis has been carried out – the analysis has been completed. ‘Stopped’ and ‘Completed’ are in the **Tasks** menu.

**Uniquely identifying each task**

Each task has a built in 9-digit ID, which is automatically assigned randomly, to aid in tracking. This can be exported along with any other detailed information about the tasks. Unlike the task number, this number does not change when the task is moved to other parts of the hierarchy or pasted into another file, so it can be used to keep track of specific tasks as the file is updated.

**Detaching and attaching tasks**

Tasks may be detached as individual files, edited by the original analyst or team members, and then re-attached to the main file where they originated from. Some applications of these features include:

- Reducing the size of the analysis so it is easier to review or display
- Putting aside parts of the analysis for late construction
- Delegating parts of the analysis to other team members

The advantage of using detach and attach over import or hyperlink properties is that TaskArchitect provides support to keep the approach to the analysis consistent across the original file and the detached file(s). It provides a reminder if an attempt is made to alter the properties definitions in the original file or the detached file the system warns that the files are linked together through the detach function and that altering the property definitions may make the analyses incompatible. However, the user may choose to ignore this warning and alter the definition anyway.

In order to make hyperlinks between independent TaskArchitect files that are not detached part of the same file, use the property type ‘hyperlink’. See hyperlink properties in ‘Chapter 4 – Recording information about tasks: task properties’. While hyperlinks enable quick jumps to be made to tasks in other files, they do not enable those tasks to be incorporated into the original file – use Import to copy tasks into the original file.

In order to import part or all of a separate TaskArchitect file see ‘Import’ in this chapter.
**Note:** Detached tasks are a collection of parts of one file, rather than a library of unrelated parts. As such, tasks may only be re-attached to the original main file (or parts of the file that were detached from the original). The file name must not be altered and while property values can be changed, the property definitions should not be altered. When you are ready to re-attach a file, put it back in the same folder as the main file.

**Detaching a task or file**

To detach a task from the main file:
From the main menu choose File and select Detach tasks ….

Expand the task hierarchy, by clicking on the ‘+’ signs, until the tasks that you want to detach are displayed.

Select the tasks that you want to detach by clicking within the box immediately to the left of the box. A check mark will appear in each box, and the background to the task name will change colour. Just as in the Tabular View, selecting a parent task automatically selects all of its children tasks. It is not
It is possible to select a parent task and only some of its children tasks – all of them will be selected. You can also use the buttons on the right of the dialogue box to select all of the tasks at a particular level in the hierarchy.

Click on OK. The task(s) will be detached and saved in the same directory as the main file, with file names based on the name of the task followed by a unique number.

The display of tasks in the Tabular View will change to reflect that tasks have been detached. Detached tasks will be marked with a horizontal yellow arrow next to the name of the detached task(s).

You can jump from the parent file to the detached file(s) by opening the task details window for the task that was detached (or the Form View for that task) and clicking on the filename for the detached task, shown in blue.
Note: The plan for the detached task is no longer shown in the task details window of the parent file. This is because the plan is now ‘owned’ by the detached task and can only be edited in its own file.

By clicking on the file name of the detached task you will be asked if you want to save the changes in the parent file. You will then be taken to the detached file:

![Image of TaskArchitect interface showing detached task]

In this case the yellow arrow indicates that the task was detached from a file.

**Re-attaching a task or file**

Files that were at one point detached from the main or parent file can at a later time be re-attached.

From the main menu choose File select Attach tasks …,
Expand the task hierarchy, by clicking on the ‘+’ signs, until the tasks that you want to re-attach are displayed. The tasks that have already been detached will already be checked off.
Select the tasks that you want to attach by clicking within the box immediately to the left of the box.
Note – you will not be able to select tasks that have not previously been detached. You may select all tasks that were once detached by clicking on the button ‘Select all detached tasks’.
A check mark will appear in each box
Click on OK. The task(s) will be re-attached into the main file.

The display of tasks in the Tabular View will change to reflect that tasks have been re-attached – the attached tasks will show in the list and the yellow arrow indicating that a task had been detached will be removed.

**Note:** You will not be able to re-attach tasks if you alter their file names.

**Moving tasks between TaskArchitect Files**

Tasks can be simply moved between open TaskArchitect files using cut/copy and paste. Open both files then cut or copy then paste the files just as you would within a single file.

If the property definitions for each file are identical then the properties will be pasted as well as the task names and task hierarchy. If the definitions are not identical then a caution message will be displayed and the task names and hierarchy will be pasted.

Tasks can also be moved between files using Import – see below.

**Linking TaskArchitect files together**

Links can be formed between TaskArchitect files that will open the linked TaskArchitect file at the task where the link is pointed. This can be used to enable very large analyses to be created using multiple
files, links between related activities clearly shown and links across team activities shown. Links are defined using the task property definition called ‘hyperlink’. See property definitions in ‘Chapter 4 – Recording information about tasks: task properties’

**Import**

The import feature is designed to import task names and task properties from either non-TaskArchitect files (text files) or TaskArchitect files. Tasks can also be imported from MindManager™ MindMaps.

Text files with the tasks indented using tabs to represent the hierarchy are the easiest files to import. These could be word processing files or Excel spreadsheet files that have been saved in **tab delimited format** or plain text files with the tasks indented using spaces. The Import feature helps the user to check the file before importing in order to identify possible problem areas and to assign properties in the file being imported to properties that are defined in the TaskArchitect file that it is being imported into.

Since imported tasks are appended to the current file, task numbers should be removed from the file before it is imported. When TaskArchitect data has been exported to a data file where the tasks are indented according to their position in the hierarchy the task numbers can be awkward to remove manually. TaskArchitect can ignore these numbers during import by selecting “strip off initial numbers from task names” within the Import dialogue. This feature enables round trip export of TaskArchitect data in an indented form to Excel for review then re-import of the data back into TaskArchitect.

Task numbers will be assigned according to the TaskArchitect format in the current TaskArchitect file. Imported data is always appended to the end of the TaskArchitect file.

Properties should be grouped in columns in the data file, separated from the task names. The TaskArchitect file **must** contain properties of the same type as those being imported — if the contents of the properties being imported is text, the TaskArchitect properties should be text type properties. The TaskArchitect file should have the same number of properties defined as the number of properties that you wish to import. **Properties can only be imported if properties have already been defined in the TaskArchitect file.**

Tasks are always imported after the last task in the file. They can then be moved to the appropriate part of the hierarchy.

**Importing non-TaskArchitect files**

TaskArchitect can import tasks from text files where data is separated either by tabs or spaces. The most common application of this feature is the import of data that was in Excel then saved in Text (tab delimited) (*.txt) format. However, if your data was space separated you can specify the number of spaces used during the import process. **Properties can only be imported if properties have already been defined in the TaskArchitect file.**

The picture below shows how data should be arranged in the file:
The first row is headers. Tasks are indented into separate columns to show the hierarchy. Property values are in columns under the property headers.

Here is an example using realistic data:

<table>
<thead>
<tr>
<th></th>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
<th>F</th>
<th>G</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Tasks</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>Task name 1</td>
<td>Property 1 title</td>
<td>Property 2 title</td>
<td>Property 3 title</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>Task name 1.1</td>
<td>Property 1 value</td>
<td>Property 2 value</td>
<td>Property 3 value</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>Task name 1.1.1</td>
<td>Property 1 value</td>
<td>Property 2 value</td>
<td>Property 3 value</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>Task name 1.1.1.1</td>
<td>Property 1 value</td>
<td>Property 2 value</td>
<td>Property 3 value</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>Task name 1.1.1.2</td>
<td>Property 1 value</td>
<td>Property 2 value</td>
<td>Property 3 value</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>Task name 1.1.2</td>
<td>Property 1 value</td>
<td>Property 2 value</td>
<td>Property 3 value</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>Task name 1.1.2.1</td>
<td>Property 1 value</td>
<td>Property 2 value</td>
<td>Property 3 value</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>9</td>
<td>Task name 1.1.2.2</td>
<td>Property 1 value</td>
<td>Property 2 value</td>
<td>Property 3 value</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Importing task names only**
From the File menu select Import ...
From the dialogue, select the name of the file to be imported. The file type should be 'Text'. Select the type of indenting used in the file to indicate the hierarchy, and the limits to be applied to the tasks being imported. If necessary select ‘Treat first row as headers’ so that TaskArchitect will ignore the first row of information in the file.

Click on the ‘Check’ button and review any error messages produced. If required, change any of the import limits, and then check again. Click on Import to import the tasks.
Importing properties

Remember that all properties **must be defined in the TaskArchitect file before** they can be imported from another file. If you have defined selection type properties the values for those selections can be imported from a flat text file using the Define Properties window.

From the File menu select Import …
From the dialogue, select the name of the file to be imported. The file type should be ‘Text’.
Select the type of indenting used in the file to indicate the hierarchy, and the limits to be applied to the tasks being imported.

Select ‘Import property values’ and if necessary select ‘Treat first row as headers’ so that TaskArchitect will ignore the first row of information in the file. Click on the ‘Check’ button to select which columns in the data file you are importing are matched against the properties already defined in TaskArchitect.

At the top of the dialogue are the headers and values found in the columns of data being imported. At the bottom are the names of the properties defined in TaskArchitect.

Select the properties that correspond to the columns of data that you want to import. If you want to ignore a column because it is a task name or it is data that you do not want to import, select (Ignore) from the drop-down list.

Click OK.
Click on Import.

Properties will be imported according to the following rules:

**Single-choice**: Any value can be imported, as long as it matches one of the defined values. Defined values and imported strings may contain commas.
**Multiple Choice**: Any comma-delimited string of values can be imported, but each substring must match a defined value in the property definition. Defined values may not themselves contain commas.  
**Number**: Any number can be imported, including E notation. Non-numbers like INF and NNUM cannot be accepted. Empty or non-numeric cells will be entered as null (undefined) values, and may acquire cascaded values in the file. If minimum or maximum values are defined, these will be checked, and non-integer values will be rejected if the variable has been set up as integer.  
**Rating Scale**: Must be imported as a number, not as the rating-scale label. Otherwise follows the rule for numbers.  
**Text String**: Imported verbatim. Initial and terminal double-quotes are removed. Initial and final spaces are removed (trimmed). Internal double-quotes are replaced with single quotes. If text is in any Unicode encoding, typographic quotes “ or ” are treated as normal characters and not as quotes. Internal angle-brackets are allowed and should survive subsequent saving and reopening of the file.  
**Picture**: File names are preserved, though the program may not find the file if it is not on the same machine. If the picture was in the same directory as the TA file, it is recorded without the full path information, and should be found regardless of the full path.  
**URL**: Preserved, subject to the same rules as text strings.  
**Task Hyperlink**: Preserved but they contain the name and not the path of the TA file. Will only operate correctly if in the same directory as the main TA file.  
**Formula, Logic Formula**: No values are imported. If these depend on imported values, they will be recalculated after the import is complete.  
**All other property types**: Imported values are presently ignored.

Please note the following additional details:  
- Use text files separated by tabs - CSV files don't work for import  
- Properties to be imported must be defined in the TaskArchitect file before the import  
- There needs to be a tab, or column, in the first line in order for properties to be imported  
- Don’t use double-quotes in task names or properties (it will convert them into single-quotes and report an error),  
- The whole of a cell, or task name, may be enclosed in double-quotes, but they will be stripped off on import.  
- If the property is multiple-choice, you can’t have commas in one of the choices.  
- Numeric fields have the usual complicated restrictions (are they numbers, do they match the definition of the property), and incorrectly-formatted values or out of range values will be reported and left blank.  
- If a numeric field is defined in Excel as a currency field it will appear to be below the minimum value set for any property  
- To strip task numbers out of the file select “strip off initial numbers from task names”.

**Importing from TaskArchitect files**  
You can import all of the tasks in a TaskArchitect file or just some of them. You can also import all or some of the properties that match the property definitions in the current file. However, if you are regularly sharing parts of a TaskArchitect file with other users then re-importing the best way to do this is using the ‘detach’ ‘detach’ functions because it will ensure that property definitions are kept consistent and the parts of the file will always be imported into the correct place in the master file.

When importing properties from TaskArchitect files the system reviews the properties in the file to be imported (the import file) and compares them against the currently open file (the master file). It will make a match with any properties that are in the same position in the property list and of the same property type. The spelling of the property name is not important. The ‘Import TaskArchitect file’ feature was designed to work on two files that based on each other and contain very similar property definitions.

The following rules apply to the import of properties:  
- Properties in the same position in the property list will be checked for a match
The spelling of the property name is not important. Properties of the same type will be imported in the following position, subject to the following:

- ‘Multiple selection’ and ‘Single selection’ property types will not be matched.
- All of the property values for either single selection or multiple selections must match the master file in order for that property to match and be imported.
- Numeric properties with different value ranges will be matched, but only the values that fit the definition of the master file will be imported.
- Task references will be imported if the referred to tasks are contained in the tasks being imported.
- Weighted sum formula properties are not imported – calculations are made according to weighted sums in the master file.
- Picture properties will be imported whether or not their values (pictures) are in the same directory, however if the picture is not present in the directory of the master file it cannot be displayed.
- Property descriptions do not affect the import of properties.

Don’t forget that any properties to be imported need to be defined in the TaskArchitect file before the import. The imported tasks are always imported after the last task in the current file.

From the File menu select Import …
From the dialogue, select the name of the file to be imported. Note - the file type should be ‘TaskArchitect’.
The file to be imported will be loaded and an outline of the tasks will be shown in the screen.

Check the tasks that you want to import. If you want to select all of the tasks check the top left task. If you want to de-select all of the tasks uncheck the top left task. Open the list up in order to check individual tasks.
Click Next
TaskArchitect will match as many properties between the import file and the master file. You can select any or all of the properties to be imported where a match has been made. Error messages will be displayed where there is no match in the master file against a property in the import file.

---

**Import from TaskArchitect file**

Select the tasks to be imported:
- 0 Operate Chlorine Injection System
- 1 Perform Routine Procedures
- 2 Perform Non-Routine Procedures

Check the tasks that you want to import. If you want to select all of the tasks check the top left task. If you want to de-select all of the tasks uncheck the top left task. Open the list up in order to check individual tasks.
Click Next
TaskArchitect will match as many properties between the import file and the master file. You can select any or all of the properties to be imported where a match has been made. Error messages will be displayed where there is no match in the master file against a property in the import file.

---

**Import from TaskArchitect file**

Select the properties to be imported:
- Property 'Notes' can be imported.
- Unable to import property 'Who performs?': The values defined in the import file do not match the main file.
- Property 'Task Reference' can be imported. References will be preserved only if the related task is also imported.
- Property 'Further' can be imported.

---

**TaskArchitect**  
110
Click Next.
TaskArchitect is now ready to import the tasks and properties from the import file. Click OK to import them.

**Copying Tasks from Excel and Pasting them into TaskArchitect**

Tasks can be both imported from Excel (see Import) and copied from Excel to TaskArchitect. Only single columns of tasks can be imported at once from Excel. If your tasks are already indented in Excel to form a hierarchy, use the import function to move them all at one time. If at any time you find that you are unable to paste tasks from Excel, clear the TaskArchitect copy function by first selecting some text in a TaskArchitect task name, selecting from the Edit menu ‘Copy’, then go back to Excel and copy the text and paste into TaskArchitect as normal.

To copy tasks from Excel to TaskArchitect:
In Excel, select a group of tasks within one excel column and copy them
In TaskArchitect, select the task that you want to paste the Excel tasks below by clicking on the task number.
Paste the tasks, either using Paste in the Edit Menu, or by using Paste in the right mouse click menu

**Note:** If at any time you find that you are unable to paste tasks from Excel, clear the copy function by first selecting some text in a TaskArchitect task name, selecting from the Edit menu ‘Copy’, then go back to Excel and copy the text and paste into TaskArchitect as normal.

**Importing MindManager™ files**

TaskArchitect can import MindManager™ files when they have been saved as XML type files. These should later be saved as TaskArchitect files.

Save your MindManager™ file in XML format by selecting the file type ‘Mindjet MindManager Maps (*.xml) in MindManager’s Save as dialogue.

In TaskArchitect’s File Open dialogue select the file type XML Files. Select the MindManager file that you want to open.

Save the file as a TaskArchitect file by changing the file extension of the file in the Save as dialogue from .xml to .ta1

**Analysis Templates**

Templates can be defined to specify any properties and any pre-defined lists of property choices that the initial analysis file will contain. For instance, you can design a template about learning needs with properties called ‘skill’ and ‘curriculum’ and ‘training medium’ with appropriate multiple choice values predefined as well. Templates also contain any of the display options selected from the Options menu item (within the Edit menu). You can also load properties into your analysis from other TaskArchitect files at any time during the analysis – see Chapter 4.

To create a template:

In an existing or not yet started analysis, define the properties plus any lists of property values in selection lists and any display options that you want to see in your template file.
Call the overall goal of the analysis – the first task in the Tabular View – the name that you would like to call the template.

Save the file
Find the file and change the file suffix from ta1 to ta0. The suffix can be changed by slowly clicking on the name of the file twice the editing the suffix. If the suffix is not being displayed, change the file display options in Windows by selecting Tools from the window toolbar, selecting Folder Options ..., selecting the View tab, de-selecting ‘Hide extensions for known file types’, then clicking on OK. Copy this template file to the ‘templates’ folder in the ‘TaskArchitect’ folder where you originally installed the software. This will normally be within the ‘Program files’ folder on your hard disk.

**Note:** The template that you have created will appear in the Wizard with the same name as the first task in the file, not the name that you gave to the file.

**Note:** If you update TaskArchitect this folder will not be changed

**Note:** If you decide to delete the TaskArchitect folder, remember to take a copy of any template files that you want to keep.

If you would like to have further customized templates, for instance logos for the top of report pages, custom box layout with properties shown in the boxes contact support@TaskArchitect.com.

**Check spelling**

The spelling of task names can be checked using the spelling checker. From the Tools menu, select ‘Check Spelling’.
Check the analysis

The whole analysis in individual tasks can be checked against a set of analysis rules. From the Tools menu select 'Analyse this task' or 'Analyse all tasks'.

The rules used in the checker are defined and stored in the TaskArchitect file using XML. If no rules are present in the file then the checker will not find any problems. To add new rules contact sales@taskarchitect.com

AutoSave

When the user is idle for a few seconds and automatic save is performed to a hidden file, which can be optionally recovered if the program crashes. If the program crashes it will automatically re-open the Autosave file next time that the program is used. The best practice is to save the re-opened file under another name then continue to edit it as normally. In the case of errors in a file, please contact support@TaskArchitect.com.